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1 Welcome to Leaf
Capture

Welcome to Leaf® Capture. The Leaf Capture help system shows you
how to take full advantage of the tools and functionality provided in the
Leaf Capture software. Simple step-by-step instructions guide you
through every aspect of your workflow from taking a shot to making
adjustments, editing and processing your images.

In this guide:

Using Leaf
Capture
on page 3

Familiarize yourself with the Leaf Capture workspace and
the tools and functionality that are used throughout the
software.

Shooting an
image on page 33

The shooting topics teach you how to create your camera
settings, take and name your shots and store them for later
use.

Adjusting an
image on page 57

Once you have taken your shots, you can evaluate and
make adjustments to your images. These topics teach you
how to use the tools and functions for assessing and
improving your images.

Editing an
image on page 89

These topics includes a description of all the necessary
tools for presenting and organizing your images.

Processing an
image on page 101

Once you are happy with your image, you can process it to
another file formats such as tiff or jpeg. To learn how, read
these topics.
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2 Using Leaf Capture

Orientation to the workspace

The workspace contains four panels, an image area, and tools to
streamline your workflow.

Use the panels to select your shoot settings, evaluate and adjust your
shots, organize your images and process your images into other file
formats. In the image area, view and compare your images while
monitoring the status of any running processes on the status bar.

The workspace includes the following areas and tools:

A. The menu bar

B. The main toolbar

C. The panels



D. The Detail and Navigation panes

E. The lower bar

F.  The status bar

G. The image area

H. The preview area

I.  The editing toolbar

The menu bar

The menu bar contains menus with commands for Leaf Capture.

 

See also:

Reference on page 121

The main toolbar
The main toolbar contains tools for organizing your files and the layout
of the image area.

Open—Open an image or folder in the image area.

Open the Shots folder—Open and displays the
Shots folder in the image area.

Save—Save the selected image.

Send to Process Queue—Send the selected
image to the Process queue.
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In Preview view, only the preview image
appears in the image area.

Note: If you selected multiple images
before changing the view to Preview
view mode, Leaf Capture disregards the
selection.

In the preview with horizontal or
vertical thumbnails views, the image
area is divided into two sections; the
thumbnail area and preview area. If no
image is selected, the preview area is
blank. If images are selected, the
spotlight image is displayed in the
preview area, and the remaining images
are displayed as thumbnails.

By default, Leaf Capture opens in the
Preview with vertical thumbnails view.

Tip: To resize the preview and
thumbnail areas, drag the partition bar
located between the two areas.

Note: When you change the view mode, the
spotlight image is not affected.

Thumbnail view—Display all the images as
thumbnails in the image area.

Compare view—preview images side by side for
comparison.

Set candidate as master—switch between the
master and candidate image when viewing two
images in compare view.

Move All with Spotlight—zoom and pan
multiple images in compare view.

Match All with Spotlight—set the images in
compare view to the same zoom and relative
location as the spotlight image.

Slide Show—In Slide Show, view each image as a
slide in a slide show. Choose to view all the
images in a folder, or only selected images. Move
backwards or forwards in the slide show using
the Up and Down arrow keys.

Orientation to the workspace 5



Resize Thumbnails—Move the slider to change
the size of the thumbnails of any view

 Sort by—Sort the images in the folder.

 Show—Select which images you want to show in
the open folder.

Previous Image—Move to the previous image in
the folder or selection according to the display
sort order.

Next Image—Move to the next image in the
folder or selection according to the display sort
order.

Open Preview Monitor Window—Open a
preview monitor to monitor images on a second
screen or window.

See also:

Opening a folder or image on page 25
Saving an image on page 28
Monitoring the process on page 102
Viewing shots in the preview monitor on page 90
Comparing your images on page 91

Showing a slide show

Show a slide presentation to present your images.

In the slide show, the Leaf Capture workspace disappears to show a
slide show your images. You can choose to view all the images in a
folder, or only selected images.

 This task is performed in slide view.

1. If you want to include only specific images in the folder, select the
images that you want to present. Otherwise, all the images in the
folder are included in the presentation.

2. On the main toolbar, click Slide Show .
To move backwards or forwards in the slide presentation, on the
keyboard, press the Up and Down arrow keys.

See also:

The menu bar on page 4
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The panels
Leaf Capture contains four functional panels which are designed and
ordered in accordance with the major actions you perform in your
workflow.

Browse panel View a directory of all your drives, and manage your folders
and image files.

Shoot panel Prepare for your shoot, and work on your images as you shoot.

When tethered to the Leaf AFi camera systems or Rollei®

eShutter device, control the camera.

When activated by a dongle, use the Live View area to view a
real-time, video-like image.

Adjust panel Use the tools and information to evaluate, analyze, and edit
your captured images.

Process panel Set the size, color, and destination settings for your processed
images.

The Shoot, Adjust, and Process panels have tabs which contain

grouped functional tools. Some tabs have an options arrow , which
you can click and set the tab functionality, for example, standard or
advanced mode.

Tip: By default, the tabs open in standard mode. When you are familiar
with Leaf Capture and wish to use more sophisticated tools, switch to
advanced mode.

Tip: The panel area can be closed to enlarge the image area.

See also:

Showing and hiding the functions area on page 7

Showing and hiding the functions area
Leaf Capture contains four functional panels which are designed and
ordered in accordance with the major actions you perform in your
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workflow. Hide the functions area to enlarge the image area in your
workspace.

In the View menu select Hide Functions Area.

To show the functions area again, in the View menu, select Show
Functions Area.

See also:

The panels on page 7

Opening the Detail pane

The Detail pane enables you to view areas of the spotlight image at the
scale and sharpness specified on the Sharpness and Size tabs.

By default, the pan tool is active when you hover over the Detail pane.
In addition, you can use the picker tool and the gray balance and
highlight and shadow pickers in the Detail pane.

You can pan the image in the Detail pane, and you can use the picker
tools to measure the exposure and gray balance.

To open the Detail pane click the Detail Pane button

 on the lower bar.

Notes:

● If no image is selected, using the detail tool automatically selects
the image and sets it as the spotlight image.

● If you have selected more than one image, using the detail tool
automatically selects the image sets it as the spotlight image.
The selection is not lost.

See also:

About sharpening an image on page 82
Size overview on page 103
Evaluating a shot on page 46
The editing toolbar on page 12
Pixel information on page 20
Pixel selection tools on page 80

Selecting the area to view in the Detail pane

Requirements: The Detail pane must be open.

1. On the editing toolbar, click Detail .
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2. Click an area on an image in the preview area or thumbnails.

The area you selected appears in the Detail pane at the scale and
sharpness specified on the Sharpness and Size tabs. The selected
area is marked in the preview area and thumbnails by a green
rectangle.

3. To move the area that is shown in the Detail pane, do one of the
following:

● In the preview area, drag the green rectangle to the desired location.
● In the Detail pane, click on the image and drag it to the desired

location.

4. To change the scale of the area shown in the Detail pane change the
Scale on the Size tab.

Note: If no image is selected, using the detail tool automatically selects
the image and sets it as the spotlight image.

Note: If you have selected more than one image, using the detail tool
automatically selects the image sets it as the spotlight image. The
selection is not lost.

Using the Navigation pane

When you magnify an image, areas of the image disappear from view
in the preview area.

The Navigation pane shows the full image with the magnified area
marked by a green box. The box shows the position of the magnified
area in the image. Use the Navigation pane to navigate the image and
bring the hidden areas into view.

1. To open the Navigation pane, click the Navigation Pane button

 on the lower bar.

2. Use the zoom tool  to magnify an area of the image in the
preview area.

3. In the Navigation pane, drag the green rectangle to another area on
the image or click the area that you want to see in the preview area.

Note: You cannot zoom in the Navigation pane.

See also:

Using the zoom tool on page 14
Evaluating a shot on page 46
Keyboard shortcuts on page 115
The editing toolbar on page 12
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The image and preview areas
The image area displays your images in the selected view mode. The
preview area is the area within the image area where the spotlight
image is displayed.

In views with preview, the preview area is blank if you do not select an
image. When you select an image, it becomes the spotlight image and
is displayed in the preview area. When you select several images, the
spotlight image is displayed in the preview area.

The spotlight image is marked in the thumbnails by a green frame.
Other images in your selection are marked with a white frame. All
selected images have a darker background than images that are not
selected.

By default, the following information is displayed for each image:

● File format
● File name

In addition, the following information is displayed when applicable:

Flags

Red save icon if image is unsaved
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Process icon if image is being processed

Clock icon if image is in waiting status

Note: Changing the view mode does not affect the spotlight image. The
spotlight image remains the same in every view mode.

 

When you roll the mouse over the image name, additional image
information is displayed:

● File name
● Captured with
● Created
● Modified
● Size
● ISO

Tip: To change the file name of the spotlight image, roll the mouse over
the file name. When the pointer changes, click and type a new name.

Note: Some of the editing tools function at any location in the
thumbnail or preview area. Other tools, for example the loupe tool, are
only active when you toll the mouse over the image itself.

See also:

Working on images in Leaf Capture on page 27
Activating live view on page 51

Changing the spotlight image in a selection

 This task is performed in the Image area.

Press Alt + click an image amongst the selected group.

Note: If you click an unselected image, without pressing Alt, the
current selection of images will no longer be selected and the image
that you selected will become the spotlight image.
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The editing toolbar
Running vertically to the right of the image area, the editing toolbar
contains tools for evaluating, editing, and adjusting your images.

Crop: Use the crop tool to select an area of the image if you want to
process a reduced area of the image.

Loupe: Use the loupe tool to check the focus of your image. The Loupe
tool shows an area of the image at a scale of 100% and enables you to
evaluate the current sharpness settings.

Detail: This detail tool marks the area of the image that is shown in the
Detail pane.

Zoom: You can zoom into an image to a maximum magnification of
400%, and navigate the image using the scroll bar or pan tool, either in
the image area or in the Navigation pane.

Pan: When you zoom into an image, areas of the image disappear from
view. Use the pan tool to bring hidden areas into view. You can also use
this tool with the Shift key to move the layout overlay and grid lines.
Use the pan tool together with the Navigation or Detail panes.

Picker: Use the picker tool to view pixel information about a specified
spot on the image.

Layout Overlay: Use the layout overlay tool to show or hide a layout
overlay over the an image or the live view display.

Flag: Use the flag tools to tag an image.

Image Info: Use the Image Info to view metadata created in the Image
Settings dialog box at the time the shot was taken. The Image Info
dialog box also contains EXIF data from the shoot. You can add
information, if desired.
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Grid: Use the grid tool to help you with the composition and alignment
of an image.

Trash: Trash unwanted images and folders by dragging them to this tool.

Note: Some of the editing tools function at any location in the
thumbnail or preview area. Other tools, for example the loupe tool, are
only active when you toll the mouse over the image itself.

 

The following tools can be customized in the Tools Options box:

● Crop tool
● Loupe tool
● Picker tool
● Flag tool
● Overlay tool
● Grid tool

See also:

Moving an image to trash on page 99

Customizing the editing tools

You can customize the following tools in the Tools Options box:

● Crop tool
● Loupe tool
● Picker tool
● Flag tool
● Overlay tool
● Grid tool

1. On the lower bar, click the Tool Options button

.

2. From the tool list, select a tool.

3. Make the desired adjustments to the available options.

4. To return the options to their original settings, Click Reset.

See also:

The lower bar on page 19
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Cropping an image

The crop tool enables you to set or edit a crop. The dimensions of the
crop are displayed on the Process panel Size tab.

1. On the editing toolbar, click Crop tool.

2. Drag the mouse over the part of the image you want to create a
marquee.

Tip: To maintain a square, press Shift while dragging.

3. If you wish to resize your crop, do one of the following:

● Place the mouse on one of the corners of the marquee and when
the mouse changes, click and drag the corner to the desired
position.

● Place the mouse on one of the sides of the marquee and when
the mouse changes, click and drag the side to the desired position.

Tip: To move the crop marquee without changing its dimensions,
click inside the marquee and drag it to the desired location.

See also:

Size overview on page 103
Adjusting the develop curve automatically on page 63

Customizing the crop tool

Set or edit a crop using the crop tool. The dimensions of the crop are
displayed on the Process panel Size tab.

1. On the lower bar, click the Tool Options button

.

2. Make sure that Crop Options is selected in the tool list.

3. Use the Lightness slider to adjust the light of the non-selected area.

4. Use the Opacity slider to adjust the opacity of the non-selected area.

Using the zoom tool

The zoom tool is found on the editing toolbar.

Working with images

Use the zoom tool to magnify or reduce the scale of an image. The
highest magnification is 400%. A magnification of 100% shows the full
resolution of the sensor. The smallest magnification is a full image
display (fit to preview).

Use the scroll bar, Pan tool, or Navigation pane to view different areas
of the image.
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Notes:

● To view the image at 100% zoom, double-click the zoom tool.
● To zoom out, press the Alt key and click the image.

 

Working with Leaf live view

When working with Leaf live view, you can use the zoom tool to view
the image at 1:1, or at full image display.

Notes: In live view, the zoom tool has the following restrictions:

● You cannot make any intermediate magnifications
● You cannot pan across or scroll through an image

See also:

Using the Navigation pane on page 9
Keyboard shortcuts on page 115
Leaf live view functions on page 49

Showing a grid over your image

Use the grid tool to place a grid on your image.

1. On the editing toolbar, click Grid .

2. To hide the grid, click Grid  again.

See also:

Leaf live view functions on page 49
Composing with live view on page 53

Moving the grid lines

For this task, the grid tool  must be active.

1. Press Shift + Space and point to the grid line that you want to move.
The mouse cursor changes.

2. Drag the grid line to the desired location.

Setting grid attributes

1. On the lower bar, click the Tool Options button

.
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2. Set the grid options:

● In the Style box, select the style of the grid lines.

● Click the color box  to set the color of the grid lines.
● In the Vertical lines box, type the number of vertical lines you

want in your grid.
● In the Horizontal lines box, type the number of horizontal lines

you want in your grid.

3. Click Reset.

Using the layout overlay tool

For this task, a layout overlay must be open.

1. On the lower bar, click the Tool Options button

.

2. Adjust the Scale slider as required.

See also:

Evaluating a shot on page 46
Leaf live view functions on page 49
Composing with live view on page 53

Showing a layout overlay

Requirements:

Before you begin, you must open a layout overlay.

Use a layout overlay to compose a shot according to a predefined
digital layout. By imposing a layout overlay on your image or live view
display, you can align your subject with the predefined composition in
the overlay.

On the editing toolbar click Show/Hide Layout Overlay .

See also:

The editing toolbar on page 12

Opening a layout overlay

You can use a layout overlay to compose a shot according to a
predefined digital layout. By imposing a layout overlay on your image or
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live view display, you can align your subject with the predefined
composition in the overlay.

1. In the editing toolbar, click Show Layout Overlay .

If this is the first time you are opening a layout overlay since opening
the Leaf Capture software, the Open dialog box appears. Skip to
step 3.

If you have worked with a layout overlay already, the last used
layout overlay is displayed over the preview image or live view
display. If you wish to change the overlay used, proceed to step 2.

2. From the File menu, select Open Overlay.

3. In the Open dialog box, navigate to the desired image and click
Open.

The layout overlay is displayed over the preview image or live view display.

Tip: You can also drag an image into the preview area.

Moving the layout overlay

Requirements: For this task, the layout overlay tool  must be active.

Press Shift and use the pan tool to move the layout overlay.

Note: You can also control the layout overlay by selecting View >
Layout Overlay.

 

Adjusting the opacity of a layout overlay

Requirements: For this task, a layout overlay must be open.

1. On the lower bar, click the Tool Options button

.

2. Adjust the opacity slider as required. By default, the overlay and the
image or live view streamed image are displayed at 50% opacity.

Using the loupe tool

The loupe tool enables you to view an area of your image at 100%
magnification.

You can use the loupe tool in a thumbnail, and in the preview area.

1. On the editing toolbar, click Loupe tool.

Moving the layout overlay 17



2. Click a point on a thumbnail or image in the Preview area. To specify
a different area, drag the loupe box over the image.

Tip:  You can also use the loupe tool on thumbnails.

Note: You can not select an image with the loupe tool. To select an
image when the loupe tool is active, press the ALT key.

 

See also:

Evaluating a shot on page 46

Customizing the loupe tool

1. On the lower bar, click the Tool Options button

.

2. Make sure that Loupe Options is selected in the tool list.

3. In the Size box, select the loupe box size.

4. If you want to view the loupe box with sharpness, select Preview
Sharp.

Using the picker tool

Use the picker tool to measure exposure (working with the histograms)
or pixel information.

You can use the picker tool in a thumbnail, a preview and in the Detail
Pane.

On the editing toolbar click the picker tool  and click a spot on
the image.

Notes

● If no image is selected, using the picker tool to click in a
thumbnail automatically selects the image, and sets it as the
spotlight image.

● If you have selected more than one image, using the picker tool in
a thumbnail automatically selects the image sets it as the
spotlight image. The selection is not lost.

Tip: To pan  the image, when the picker tool is active, press the
space bar.

See also:

Pixel information on page 20
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Customizing the picker tool

You can customize the picker size.

1. On the lower bar, click the Tool Options button

.

2. Make sure that Picker Options is selected in the tool list.

3. In the Size box, select the picker size.

The lower bar

Detail Pane
 Opens the Detail pane, which enables you to view

areas of the spotlight image at the scale and sharpness
specified in the corresponding tabs. You can pan the image
in the Detail pane, and you can use the picker tools to
measure the exposure and gray balance.

Navigation Pane
 Opens the Navigation pane, which enables you to

view a thumbnail of your full image, with a green rectangle
marking the position of the magnified area if zoomed in.

Process Queue The number of images sent to process and the number of
remaining images to be processed are displayed for quick
reference on the lower bar.

 Opens the Process Queue dialog box, where you can
monitor the status of each image sent to process. The
Process Queue dialog box contains a list of the images in
progress and their status. You can also view the image
thumbnail when you select it in the queue. When the
running image is selected, a progress bar under the
thumbnail indicates the status of the processing.
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Tool Options
 Opens the Tool Options dialog box, where you can

customize the crop, loupe, picker, flag, overlay and grid tools.

Pixel Info Pixel information for a given spot is displayed on the lower
bar.

 Opens the pixel information box, where you can view
an additional set of pixel information.

Click  to change the information displayed.

See also:

Customizing the editing tools on page 13

Pixel information

Pixel information is displayed on the lower bar. You can display the
following pixel information for a given spot:

● The location of the spot on the x and y axis
● The output color values (RGB or CMYK)
● The Lab values

See also:

The editing toolbar on page 12
Using the picker tool on page 18
Tips on gray balance on page 61
Opening the Detail pane on page 8

Selecting pixel information

Pixel information is displayed on the lower bar. You can select what
information is shown in the lower bar.

On the lower bar click the Pixel Info Options button , and select
the relevant option.

Note: If you select Output (RGB/CMYK), the values displayed and the
unit of measurement are in accordance with the Color Space you select
on the Process panel Color tab.

Displaying a second set of pixel values

Open the Pixel Info box to display a second set of pixel information. By
default, the values shown on the lower bar are the values of the
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pointer's location on the image, and the second set displays the values
of the spot where you place the Picker tool.

In the lower bar click the Pixel Info button .

Defining pixel information display

Switch the information that is displayed in the lower bar and in the Pixel
Info box.

1. On the lower bar click the Pixel Info Options button .

2. Select the relevant option from the menu to set what is displayed in
the lower bar:

● To display the measurement at the location of the pointer, select
the Show Floating check box.

● To display the measurement at the location of the Picker tool,
select Show Picked.

The status bar
Use the status bar to monitor your work.

Connect
 A red icon shows that no camera is connected to Leaf

Capture.

 A green icon shows that a camera is connected.

Save

 This icon indicates you have selected Auto Save mode
for your shots.

 This icon indicates you have selected Manual Save
mode for your shots.

Progress bar Shows the progress, in percentage terms, of the current task.
The progress bar appears for all kinds of actions, such as
loading, saving, rotating, and processing files.

For example in the image shown here, the progress bar
indicates the number of files to be loaded and the number of
files already loaded.
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Selected Files Shows the number of files currently selected out of the
number of opened files.

Unsaved Files Shows the number of unsaved files. Unsaved files have a red
disk icon in the thumbnail.

 Free Space
Shows the amount of free disk space available for storing
your shots in the Shots folder.

 Free Space
Shows the amount of free disk space available for storing
your processed images. When disk space is less than 5GB,
the icon and text are red. A message appears to alert you
that you are low on disk space.

Setting Preferences
You can set the language and background color in the Preferences
window.

Setting the background color
You can set the background color in the Preferences window.

1. In the Leaf Capture menu, select Preferences.

2. In the Image Background list, select the desired look.

Setting the language
You can set the language in the Preferences window.

1. In the Leaf Capture menu, select Preferences.

2. In the Language list, select the desired language.

Managing folders and files
Manage your images and folders in the Browse panel.

As you work, you use folders to manage your shots. Leaf Capture
automatically saves your shots in the Shots folder and saves processed
files in the Processed folder. Any images that you delete are sent to the
Trash folder.
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The Browse panel
On the Browse panel, you can view a directory of all your drives and
manage your folders and image files.

The panel is divided into two sections: the Favorites area and the
directory area.

See also:

The Favorites area on page 23
Working in the directory area on page 24

The Favorites area
The Browse panel Favorites area contains shortcuts to your most
frequently used folders. By default, the Favorites area contains
shortcuts to the Shots, Process, and Trash folders.

There is only one Trash folder in Leaf Capture. The Trash folder can
always be found in the Favorites area, and cannot be moved or deleted.
Drag images or folders to the Trash folder in the area to delete them.
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When you click a shortcut in the Favorites area, the directory tree
opens showing the relevant folder highlighted, and the images in the
folder are displayed in the image area.

You can add shortcuts to your favorite folders to the Favorites area.

See also:

The Browse panel on page 23
Adding a folder to the Favorites area on page 24
Removing a folder from the Favorites area on page 24

Adding a folder to the Favorites area
The Browse panel Favorites area contains shortcuts to your most
frequently used folders. By default, the Favorites area contains
shortcuts to the Shots, Process, and Trash folders.

When you click a shortcut in the Favorites area, the directory tree
opens showing the relevant folder highlighted, and the images in the
folder are displayed in the image area.

 This task is performed on the Browse panel.

In the directory area click the desired folder and drag it to the
Favorites area.

A shortcut to the folder is created in the Favorites area.

See also:

The Favorites area on page 23

Removing a folder from the Favorites area

 This task is performed on the Browse panel.

1. Right click the folder.

2. From the menu, select Remove from Favorites.

Note: The Shots, Process, and Trash shortcuts cannot be deleted.

See also:

The Favorites area on page 23

Working in the directory area
Use the Browse panel directory area to manage your shots and folders.

24 Chapter 2—Using Leaf Capture



To view and access the folders in a drive, click the arrow to the left of a
drive. If you click a folder, all the supported image files or folders that
reside in that folder are displayed in the image area.

Right-click in the directory area to access further options:

Expand Expand the selected folder

Open folder Open a folder

Set as Processed Folder Set selected folder as the processed folder

Set As Shots folder Set selected folder as the Shots folder

Add to Favorites Add a shortcut to the selected folder to the
Favorites area

See also:

The Browse panel on page 23

Creating a folder
Create a folder to use as the Shots or Processed folders, or to organize
your shots.

1. In the File menu select New Folder.

2. In the dialog box, type the name of the new folder.

3. Click Create.

The new folder appears on the Browse panel directory area under the
last selected folder. The new folder is automatically selected in the
directory area.

Opening a folder or image
Open a folder to dispaly all its images in the preview area, or open an
image to work on.

1. In the File menu select Open File.

2. In the Open dialog box, navigate to the folder.

3. Do one of the following:

● To open the folder, click Open. All the images that reside in the
folder open with no image selected.

● To open a specific image in the folder, select the image in the
folder, and then click Open. All the images that reside in the
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same folder open and are displayed in the thumbnails, with the
image that you chose selected.

Tip: You can also open a folder from the main toolbar , or from the
directory area.

See also:

Working on images in Leaf Capture on page 27

Selecting an image
Select an image to work on.

Double-click the image in the directory area, or click on a thumbnail
in thumbnails view or the preview area.
The image is selected, and is called the spotlight image. The image
settings are displayed in the panels.

Note: Some of the editing tools, for example, the crop tool, the
picker tool, and the detail tool, can be used to select the image in
the thumbnails. Other editing tools, for example, the flag tools and
the loupe tool, can be used to perform actions on the images in the
thumbnails, and do not select the image when used.

Selecting multiple images
Select multiple images in a view with thumbnails.

 This task is performed in the image area.

Do one of the following:

● Press Cmd, and then click the desired images.
● Click the area near the first thumbnail and then drag the pointer

over all the images that you want to select.
● Click the first thumbnail and then press Shift and select the last

thumbnail in the desired series.

The first image that you select becomes the spotlight image and is
marked in the thumbnails by a green frame. The other images in the
selection are marked with a white frame. All selected images have a
darker background than images that are not selected.

The image settings of the spotlight image are displayed in the panels.
Because more than one image is selected, the predefined setting lists
display As tagged in file.
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Any changes you make to the image settings apply to all images in the
selection.

Working on images in Leaf Capture
In Leaf Capture, the selected image is called the spotlight image. The
image settings are displayed in the panels.

The image is displayed in the preview area. If open, the image is also
displayed in the Detail pane, Navigation pane, and the Preview monitor.
If you are using a view with thumbnails, the image is marked in the
thumbnails with a green frame, as shown here:

Multiple images

You can select multiple images in a view with thumbnails. The first
image that you select becomes the spotlight image and is marked in
the thumbnails by a green frame. The other images in the selection are
marked with a white frame. All selected images have a darker
background than images that are not selected.

The image settings of the spotlight image are displayed in the panels.
Because more than one image is selected, the predefined setting lists
display As tagged in file.

Any changes you make to the image settings apply to all images in the
selection.

See also:

The image and preview areas on page 10
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Saving an image
Save changes to your images.

When you make a change to your image, the change is not saved

automatically. A red save icon  appears on the thumbnail indicating
that your image contains unsaved changes.

 

On the main toolbar, click Save .

Note: The changes you make to your image do not affect the RAW
file; they are saved alongside the RAW image data.

Using the Shots and Process folders
When you work in Leaf Capture, you use two principle folders; the
Shots folder, where your shots are saved, and the Processed folder,
where your processed images are saved. You can quickly access both
folders by clicking the shortcuts in the Browsepanel Favorites area.

The Shots and Processed folders are automatically created in your
Users > Pictures > Leaf Images folder. If desired, you can designate
different Shots and Processed folders. You can set only one folder as
the Shots folder. Similarly, you can set only one folder as the Processed
folder.

Accessing the Process folder

Your processed images are saved in the Processed folder. You can
quickly access the Processed folder by clicking the shortcut in the
Favorites area.

 This task is performed on the Browse panel.

In the Favorites area click Process .

Accessing the Shots folder

Your shots are saved in the Shots folder. You can quickly access the
folder by clicking the shortcut in the Favorites area.
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 This task is performed on the Browse panel.

Do one of the following:

● In the Favorites area click Shots .

● On the main toolbar, click Open the Shots Folder .

Designating the Processed folder
Set a folder for your processed images.

 This task is performed on the Browse panel.

Right-click the desired folder and click Set as Processed folder.

The predefined setting list

In Leaf Capture, each tab has a set of parameters which correspond to
the functionality of the tab. As you work, you make adjustments and
change the settings in each tab to suit your images.

You can save your customizations to all the parameters in a tab as a
group, known as a setting. In addition, Leaf Capture offers you a
collection of factory-created settings which are designed to match your
work conditions, for example, camera type, light conditions, and so on.

When you select a predefined setting in each tab, the tab parameters
are adjusted accordingly.

Use predefined settings:

● to apply a set of parameters to a specific image
● to apply a set of parameters to a group of selected images
● to set the parameters for your next shoot session

Note: The predefined setting list is only active if an image is selected in
the image area.
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Working with the predefined setting list

The behavior of the predefined setting list alters depending on how
many images you have selected, and the customizations you make.

Single image selected

When you select a single image, the setting saved with the image is
displayed.

Open the predefined setting list to see the list divided into three
categories, according to setting type:

● Factory: Lists all the factory settings offered by Leaf Capture
● Saved: Lists all the settings that you created and saved
● In File: Lists the setting saved with the image

If you change any setting in the tab, you create a custom setting, and
two categories are added to the list:

● Revert to Saved : added to the top of the list select Revert to Saved
to reapply the setting that is saved with the image

● Custom: the custom setting is given the name Custom <file
name>.mos.

Note: When you select a predefined different setting, or make a change

to the settings in the tab in any way, the unsaved icon  appears on
the image in the image area.

Multiple images selected

When you select more than one image, and the selected images have
the same parameter settings for the tab, the Active category is added
to the predefined setting list, displaying the common setting.

If the selected images have different parameter settings for the tab, As
tagged in images appears in the predefined setting list. Open the
predefined setting list to see more information about the settings in the
spotlight image in your selection:

● Active: shows the setting in the spotlight image
● In File: Lists the setting saved with the spotlight image

If you select a predefined different setting, or make a change to the
settings in the tab in any way, the settings are applied to all the images
in the selection.
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Taking a shot with a customized predefined setting
Use a customized predefined setting when taking shots.

Each time you take a shot, the camera automatically uses a
combination of predefined settings that together make up the settings
for the camera. Any predefined settings that you create and save can
be included in the camera settings for use in subsequent shots.

1. In the predefined setting box, select the setting that you created.

2. Click .

The Image Settings are updated and the setting that you created is
used in the next shot.

Creating or modifying a predefined setting

1. If you want to base your setting on a current setting, ensure that the
setting is selected in the predefined setting box.

2. Make changes to the parameters in the tab. Leaf Capture assigns a
name that includes the prefix Custom and the image name - for
example, Custom xxx.mos where xxx is the image name.

3. Click .

4. In the Save Preset dialog box, type the name you wish to give the
setting.

5. Click OK.

Note: When you select a predefined different setting, or make a

change to the settings in the tab in any way, the unsaved icon 
appears on the image in the image area.

6. To apply the setting to the spotlight image, click Save on the main

toolbar .

Deleting a predefined setting

1. Click .
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2. In the Delete Saved Presets dialog box, select the predefined setting
that you want to delete.

Note: You cannot delete a Factory or Active setting.

3. Click Delete.
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3 Shooting an image

When you shoot your activities revolve around the tools on the Shoot
panel. The Shoot panel appears differently depending on whether or not
Leaf live view is available.

When Leaf live view is not activated the Shoot panel is divided into the
Session Setup, Camera Control, and Exposure Evaluation expandable
areas, which contain the functions necessary for preparing to shoot, and
taking and evaluating shots.

When Leaf live view is activated the Live View area also appears.

See also:

Establishing a connection on page 35
Taking a shot on page 45

Taking shots overview
Use the tools on the Shoot panel to:

● Prepare for the shoot
● Take a shot
● Evaluate a shot

At the top of the Shoot panel, you can connect to your camera, take a
shot, and set the ISO and other camera settings.

The Shoot panel is divided into four expandable areas:

● In the Session Setup area, prepare image settings and define how to
save your shots

● In the Camera Controls area, control your Leaf AFi camera system or
Rollei eShutter device via the Leaf Capture software

● In the Exposure Evaluation area, use the tools and histogram to
evaluate your shots

● In the Live View area (enabled by dongle), you can see a real-time,
video-like image display.

See also:

Taking a shot on page 45
Shooting while editing on page 89



About the Shoot panel
Use the tools on the Shoot panel to prepare for the shoot, and to take
and evaluate shots.

See also:
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Establishing a connection on page 35
Taking a shot on page 45

Preparing to shoot

Prepare for your shoot by defining settings in the Shoot panel.

Establishing a connection

Follow the recommended steps for connecting your Leaf digital camera
back to the Leaf Capture software.

 This task is performed on the Shoot panel.

Note: For information about connecting the camera hardware to your
computer refer to the Leaf Aptus Installation Guide or Leaf AFi User
Guide.

1. Start the Leaf Capture software.

2. Click Open Camera Configuration to open the Camera
Configuration dialog box.

3. In the Camera Configuration dialog box, from the Camera list, select
the camera that you are using, and click OK.

4. Do one fo the following:

● If you connected the Leaf digital camera back to the computer

BEFORE starting Leaf Capture, click Connect .
● If you did not yet connect the Leaf digital camera back to the

computer, connect now using an Apple® FireWire® cable.

Leaf Capture recognizes the connection and automatically connects
to the Leaf digital camera back. In the lower bar, a progress bar
indicates the progress of the connection. Once connected, the
Connect icon in the Shoot panel and in the lower bar turns green,
indicating that you are successfully connected to your camera.

See also:

The lower bar on page 19
Shooting an image on page 33
About the Shoot panel on page 34
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Ending the connection between your camera back and Leaf
Capture

 This task is performed on the Shoot panel.

On the Shoot panel click the Disconnect icon .

Note: If you disconnect the FireWire cable, the communication
stops automatically.

On the status bar the Connect/Disconnect icon shows whether or not
your camera back is connected and ready to shoot.

Customizing camera configuration

 This task is performed on the Shoot panel.

1. Click Open Camera Configuration .

If you established a Connection between the camera and Leaf
Capture the name of the camera back appears in the Leaf Back box
and the serial number appears automatically. If your camera is
noted, from the Leaf Back list select a camera back. The serial
number appears as unavailable until the camera back is connected.

2. Set the camera settings as desired:

● Camera: Select the type of camera that you are using.
● Orientation: Select a shoot orientation. Auto is the

recommended orientation.

3. Click OK to apply the camera settings and close the dialog box.

See also:

Choosing a color space on page 107

Using image settings

Use image settings to define the look of your images as you shoot.

Selecting predefined image settings

Leaf Capture provides you with predefined image settings that can be
used for your shoot. If you desire, you can customize the settings and
save them for future use.
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 This task is performed on the Shoot panel Session Setup area.

In the Session Setup area from the predefined setting list, select a
predefined setting that suits the subject and environment of your
next shot.

Note: The predefined setting list contains predefined settings that
are suited to the connected digital camera back.

Customizing image settings

 This task is performed on the Shoot panel Session Setup area.

1. Click Open Image Settings .

2. Select the predefined image settings, as desired.
The settings that you define in the Image Settings dialog box are
applied to the shots you take. The settings are shown on the Adjust
and Process panels when the shot is displayed in the preview area.

3. Click OK.
In the predefined setting list the settings name prefix changes to
Custom.

4. If you want to save the image settings:

a. Click Save Selected Setting .
b. In the Save Presets dialog box, type a name for the customized

settings and click OK.

Customizing info settings

Save general information (metadata) about your shot. This information
is stored and reused for the next shot.

1. From the Camera menu select Info Settings.

2. In the Info Settings dialog box, type the desired information in the
relevant boxes.

3. Click OK.

Creating a lens calibration file

Shooting images with wide angle lenses and exploiting large format
camera movements often results in lens fall-off and color distortion. To
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correct this, use the Create Lens Calibration wizard to create a lens
calibration file and load it in the imaging module for shots you take
when shooting tethered.

For Leaf AFi-II 10 and Aptus-II 10 users, Leaf Capture is released with a
Lens Calibration Data CD. This CD contains lens calibration files, which
are unique to your imaging module, for most commonly-used lenses.
For more information on using lens calibration files, refer to the Lens
Calibration Guide for Leaf AFi-II 10 and Aptus-II 10 Camera Backs (p/n
731-01750A-EN).

You must be connected to your imaging module in order to use the
Create Lens Calibration wizard.

Note: You must choose an image taken at full sensor size.

1. In the Camera menu, select Lens Calibration > Create Wizard.

2. Follow the steps in the wizard.

3. At the end of the wizard, select the Load lens calibration check box
if you want to load the lens calibration file to your imaging module
after it is created.

4. Click Save.

5. In the Save Lens File dialog box, name and save the lens calibration
file.

If you selected Load lens calibration, the Load Lens Calibration
dialog box appears. By default, the lens calibration file you created is
selected.

6. In the % Falloff Correction box, adjust the fall off by typing the
desired correction percentage.

7. Click OK.

The lens calibration file is uploaded to your imaging module. The lens
calibration is applied to all subsequent shots while you shoot tethered,
or until you load another lens calibration file.

When you are using a lens calibration file other than the factory default

file, the following icon appears in the status bar .

Loading a lens calibration file

Load a lens calibration file to apply lens calibration to shots you take
when shooting tethered.

You must be connected to your imaging module in order to load a lens
calibration file.

1. In the Camera menu, select Lens Calibration > Load.
The Load Lens Calibration dialog box appears.
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2. Select Use Factory Default to use the factory lens calibration file, or
select Use Lens Calibration File and select the file you want to use.

3. If using a custom lens calibration file, adjust the fall off by typing the
desired correction percentage in the % Falloff Correction box.

4. Click OK.

The lens calibration file is uploaded to your imaging module. The lens
calibration is applied to all subsequent shots while you shoot tethered,
or until you upload another lens calibration file.

When you are using a lens calibration file other than the factory file, the

following icon appears in the status bar .

Managing your shots

As you shoot, you can name and save your shots in one of two ways:

● In auto save mode, each shot is automatically saved with a base
name and an enumerator.

● In manual save mode, you name and save each shot individually.

Leaf Capture saves the images in Leaf mosaic format with the file
extension .mos.

The images are saved in the Shots folder.

Saving a shot automatically

In auto save mode, Leaf Capture saves your shot with a base name that
you specify, and an enumerator that is automatically assigned to each
shot.

 This task is performed on the Shoot panel Session Setup area.

1. Click the options arrow  and select Enable Auto Save.

2. In the File Name box, type a base name for the image.

Each subsequent shot is automatically saved with this name and an
enumerator. For example, if you type the word Images in the File
Name box the next shot is saved under the name Images1.mos.

Note: The auto save icon  on the lower bar indicates you are in
auto save mode.

3. To compress your images when you are shooting tethered click Save
Compressed. This reduces the file size and saves space on your
computer.

4. To reset the enumerator in the File Name box, type a different name.
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5. To change the enumerator—for example if you would like to start
counting at 100—enter the desired number in the enumerator box.

6. To select the file enumerator separator click the options arrow ,
select File Numbering Separator, and select the desired separator.

Saving a shot manually

In manual save mode, you can save your shots manually by defining a
name for each shot before you save it.

 This task is performed on the Shoot panel Session Setup area.

1. Click the options arrow  and select Enable Manual Save.

Note: The manual save icon  on the lower bar indicates you are
in manual save mode.

2. Take a shot.

3. In the File box, type a name for your image.

4. To compress your images when you are shooting tethered click Save
Compressed. This reduces the file size and saves space on your
computer.

5. Click Save .

Note: If you do not manually save your current shot, it is lost when you
take your next shot.

Designating a Shots folder (Browse panel)

When you take a shot it is automatically saved in the Shots folder. Leaf
Capture automatically creates this folder in your Users > Pictures >
Leaf images > Shots folder. However, you can designate a different
folder to receive your shots.

 This task is performed on the Browse panel.

1. In the directory area, locate and select the desired folder.

2. Right-click, and from the menu, select Set As Shots folder.

Until you designate a different folder all your future shots are saved
automatically in this folder. The Shots folder in the Favorites area now
relates to the folder you designated.

Note: The amount of remaining disk space is indicated on the status bar.
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Designating a Shots folder (Shoot panel)

When you take a shot it is automatically saved in the Shots folder. Leaf
Capture automatically creates this folder in your Users > Pictures >
Leaf images > Shots folder. However, you can designate a different
folder to receive your shots.

 This task can be performed on the Shoot panel.

1. Click Choose a Different Shots Folder .
2. Browse to the desired folder, or click Create new folder.
3. Click Choose.

Until you designate a different folder all your future shots are saved
automatically in this folder. The Shots folder in the Favorites area now
relates to the folder you designated.

Note: The amount of remaining disk space is indicated on the status bar.

Controlling the camera
Use the controls in the Shoot panel Camera Control area to control
your camera.

Camera controls are available for Leaf AFi and AFi-II camera systems.
In addition, you can set the aperture and shutter speed for the Rollei
and Schneider eShutters.

You can:

● Set the ISO
● Take a shot
● Set the sensor size (Leaf AFi-II 10 only)
● Set the exposure mode
● Set the aperture
● Set the shutter speed
● Set exposure compensation
● Set the flash sync mode
● Lock the mirror
● Use the exposure meter to assess the exposure of your shot

The exposure meter displays your shot's ambient light reading in real
time, and updates as you adjust the aperture, shutter speed, and
exposure compensation settings. At 0.0 EV, your shot has the correct
exposure.
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When set to program, aperture priority, or shutter priority exposure
modes, the exposure meter will show a reading of about 0.0 EV. In
manual, B, or T modes, you must adjust the aperture, shutter speed,
and exposure compensation settings to reach a reading of 0.0 EV.

Setting the ISO

Select the ISO speed for the shoot.

 This task is performed on the Shoot panel.

Note: The available ISO speed values vary according to the defined
digital camera back.

Select the desired ISO speed from the list.

Selecting the sensor crop size

When shooting tethered, use the Leaf SensorFlex technology to crop
the camera sensor to one of three pre-determined sizes. When
cropped, the active imaging area on the sensor is reduced to the crop
size, and the selected sensor size is active in Live View.

Available for Leaf AFi-II 10 camera systems only.

 This task is performed on the Shoot panel.

In the raw file input size drop-down list, select one of the predefined
crops:

● Full size (6000 x 9334 pixels)
● 3 x 4 (6000 x 8000 pixels)
● 1 x 1 (6000 x 6000 pixels)

In Leaf Capture, the output size is automatically updated in the camera
configuration, and in the Process panel Size tab.

Tip: To see the cropped area in the viewfinder, insert the viewfinder
mask supplied with your Leaf AFi-II 10 camera system into the
viewfinder frame.

In the Leaf AFi-II 10 camera system, the active pixels of the sensor are
adjusted to the crop size. The image displayed on the imaging module
reflects the cropped sensor size.
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Setting the exposure mode

Set the exposure mode remotely using the Leaf Capture software.

Requirements: On the Leaf camera system, set the AE switch to red dot.

This feature is available for Leaf AFi and Leaf AFi-II camera system
users only.

 This task is performed on the Shoot panel Camera Control area.

In the exposure mode drop down list, select the desired mode:

● Program
● Shutter Priority
● Aperture Priority
● Manual
● Camera B (Bulb)
● Camera T (Toggle)

For more information on exposure modes, see the camera system
User Guide.

Depending on your selection, the relevant controls are available in
the Camera Control area.

Setting the aperture

Control the aperture remotely using the Leaf Capture software.

This feature is available for Leaf AFi and Leaf AFi-II camera system and
Rollei and Schneider eShutter users only.

 This task is performed on the Shoot panel Camera Control area.

Use the single arrows to adjust the aperture a fraction of an f-stop,
or the double arrows to move one full f-stop.

Note: The lens type is automatically detected, and the single arrow
adjusts the aperture by one tenth or one third, accordingly.

The exposure meter displays your shot's ambient light reading in
real time, and updates as you adjust the aperture, shutter speed,
and exposure compensation settings.

See also:

Using the depth of field preview on page 55
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Setting the shutter speed

Control the shutter speed remotely using the Leaf Capture software.

This feature is available for Leaf AFi and Leaf AFi-II camera system and
Rollei and Schneider eShutter users only.

 This task is performed on the Shoot panel Camera Control area.

Use the single arrows to adjust the shutter speed settings a fraction
of a stop, or the double arrows to move one full stop (depending on
the lens).
The exposure meter displays your shot's ambient light reading in
real time, and updates as you adjust the aperture, shutter speed,
and exposure compensation settings.

Setting exposure compensation

Compensate the exposure remotely using the Leaf Capture software.

This feature is available for Leaf AFi and Leaf AFi-II camera system
users only.

 This task is performed on the Shoot panel Camera Control area.

Use the single arrows to adjust the EV compensation in 0.3 EV
increments, or the double arrows to adjust the EV compensation in
1.0 EV increments (depending on the lens).
The exposure meter displays your shot's ambient light reading in
real time, and updates as you adjust the aperture, shutter speed,
and exposure compensation settings.

Setting the metering mode

Set the metering mode on your Leaf camera system.

This feature is available when the metering mode switch is set to red dot.

This feature is available for Leaf AFi and Leaf AFi-II camera system
users only.
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 This task is performed on the Shoot panel Camera Control area.

Click the metering mode button to toggle between multizone

, center weighted , and spot 
metering.

Setting the flash sync mode

Set the camera flash sync mode to trigger the flash immediately as the
shutter opens (normal sync) or to trigger the flash approximately 3 ms
before the shutter closes (rear sync).

This feature is available for Leaf AFi and Leaf AFi-II camera system
users only.

 This task is performed on the Shoot panel Camera Control area.

Click the flash sync button to toggle between front normal flash

sync  and rear flash sync  mode.

Locking the mirror

Lock your camera's mirror into the up position to increase shooting
speed and to avoid any possible vibrations.

This feature is available for Leaf AFi and Leaf AFi-II camera system
users only.

 This task is performed on the Shoot panel Camera Control area.

Click the mirror up button .
The mirror moves into the up position until you click the mirror up
button a second time, or until you release the mirror on the camera
by pushing the mirror lock button.

Taking a shot

Take a shot from Leaf Capture.

Requirements: Ensure your camera is connected to the Leaf Capture
software.
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You can shoot a shot by physically pressing the camera’s shutter
release button, or remotely from Leaf Capture.

 This task is performed on the Shoot panel.

Note: Some cameras do not have remote shooting capabilities.

Click the Take a Shot button .

See also:

Shooting an image on page 33
About the Shoot panel on page 34
Establishing a connection on page 35

Evaluating a shot

Evaluate your shots on the fly using the tools in the Shoot panel
Exposure Evaluation area to check exposure, and to define the gray
balance for future shots:

● Camera gray balance picker
● Exposure alarms
● Histogram

Check the focus of your shots in one of the following ways:

● Using the loupe tool
● Using the Detail pane
● Using the Navigation pane

Check the composition of your shots by shooting with an overlay.

See also:

Using the Navigation pane on page 9
Opening the Detail pane on page 8
Using the loupe tool on page 17
Using the layout overlay tool on page 16

Using the camera gray balance picker (Shoot panel,
Exposure Evaluation area)

The Camera Gray Balance Picker can help you achieve consistent,
predictable results in your work. Use the picker to balance the grays in
the image prior to evaluating colors.

When you use the picker to click a gray point in your image-for
example, an 18% gray card in the shot-Leaf Capture makes this point
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neutral, that is, the RGB values of the point become equal. The
remaining colors in the image are adjusted in relation to this point.

 This task is performed on the Shoot panel Exposure Evaluation
area.

1. Click the Camera Gray Balance Picker tool .

2. On the image, move the pointer to a midtone gray point (18%) that
you want to set as neutral, and click.
The image's gray balance setting is updated automatically by the
selected gray point, and your subsequent shots are balanced using
this setting until changed. The image setting becomes 'custom' due
to this change.

Using the exposure alarms

Overexposed and underexposed areas in your image may lack image
detail and not respond well to digital processing. The exposure alarms
highlight the areas of the image that are either overexposed or
underexposed, and the values are marked on the histogram.

 This task is performed on the Shoot panel Exposure Evaluation
area and on the Adjust panel Develop Curve tab.

Click the Overexposure Alarm , the Underexposure Alarm

, or both.

A mask appears on the overexposed or underexposed areas of the
image.

If you are working in advanced mode, the overexposed or
underexposed areas are also indicated on the histogram.

You can customize the color of the mask, the blinking of the mask, and
the overexposure and underexposure limit lines that appear on the
histogram.

See also:

About the histogram on page 48
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About the histogram

Use the histogram in the Shoot panel Exposure Evaluation area and in

the Adjust panel Develop Curve tab advanced mode  to evaluate
the lighting of your shot.

The histogram is a graphic representation of the exposure data (pixels
at each intensity level) in a captured image displaying the overall pixel
distribution of the image.

The histogram is read via the x-axis, which is a scale of f-stop values
ranging from +3 f-stops to -8 f-stops. These numbers represent the
relative exposure of the image in f-stops. Zero is the f-stop at the
midpoint of the scale and is equivalent to an 18% reflectance value. The
width of the histogram represents the range of f-stops in the image. A
shaded area above the x-axis represents the distribution of pixels at the
different exposure levels in the image in terms of highlight, shadow, and
midtone values.

You can use the histogram to view changes that you make to the
exposure and the lighting of the scene. For example, by looking at the
histogram, you can determine whether your image is flat, and how
much catchlight area you have captured. You can then make exposure
or lighting adjustments and view the adjustments in the image-in one
of the display windows, and for a more accurate view, via the data in
the histogram.

The histogram enables you to quantitatively assess your image in terms
of exposure. It is a tool that you can use continually throughout your
photo session, to verify that your shots are correctly exposed. The
position of the histogram on the horizontal axis reflects exposure of the
image. Images with effective lighting contrast have a histogram that
spans the lightest to the darkest point.

A properly exposed image has a highlight area that falls in the
histogram at around +2 f-stops, leaving an adequate range of between
+2 and +3 f-stops for any bright or shiny elements (such as catchlight)
in the image.

The Histrogram Channel list enables you to display the histogram of
each color channel:

● L L for luminance. Select L to check the overall exposure.
● R for the red channel
● G for the green channel
● B for the blue channel
● A for all channels. Select A to show both the overall exposure and

the distribution of red, green, and blue light levels in the image. Use
this view to check that the highlight points in brightly colored
objects are not overexposed.
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 The picker tool provides an indication of the relative exposure (in f-
stops) of the selected spot on the histogram.

If the selected point is black and white, the histogram displays one
black line, at the relative exposure value point on the x-axis.

Lines are displayed on the histogram to mark the overexposed and
underexposed limits. If the selected point is a colored point, the
histogram displays the following lines:

● A short red line representing the red channel of the spot
● A short green line representing the green channel of the spot
● A short blue line representing the blue channel of the spot
● A black line represents the lightness value that the spot would have

if it were neutral

A mask is displayed on the histogram when the overexposure and
underexposure alarms are on.

See also:

Using the exposure alarms on page 47
Advanced develop curve tools on page 65
Detaching the histogram on page 90

Shooting with an overlay

Overlay and grid tools are accessed from the editing toolbar.

Use a grid or layout overlay as you shoot to help you compose your shots.

● Use the layout overlay tool to show and hide an overlay
● Use the grid tool to place a grid over your image

See also:

Showing a layout overlay on page 16
Moving the grid lines on page 15

Leaf live view functions

● Activate the live view.
● Change the live view exposure time
● Focus the image:

❐ Use the focus meter to measure the contrast in a selected area
❐ Use the zoom tool to change the magnification of the image

● Use Leaf live view to compose an image:
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❐ Use the layout overlay tool to show and hide the overlay
❐ Use the grid tool to place a grid over your image

● Save the live view image

See also:

Using the zoom tool on page 14
Using the layout overlay tool on page 16
Showing a grid over your image on page 15
Using the focus meter on page 53

Using Leaf live view
Leaf live view enables you to see a real-time, video-like image in the live
view display of Leaf Capture.

Note: For Aptus users, to use live view you must have purchased the
live view dongle, and activate it.

Live view has several uses:

Focusing
● Digital focus—On a view camera, it is often inconvenient to place

and remove the ground glass. Focusing directly on the sensor using
the live view display enables a high degree of precision with relative
ease.

● Accuracy—If you use the ground glass of the camera to focus, you
may lose the accuracy of the focus by inadvertently moving the
camera when you attach  the digital camera back. When using the
live view display as the viewfinder, you do not encounter this type of
problem.

Composition
● Viewfinder—For large format cameras that do not include a camera

viewfinder, the live view acts as your viewfinder. With other
cameras, live view is convenient when you do not want to view the
image through the camera’s ground glass or viewfinder—the live
view display acts as your viewfinder. Live view is also useful when
the camera is turned on it's side; the live view displays the image right-
side up.

● Layout—You can compose a shot according to a predefined layout
overlay from a previous shoot or from a digitized drawing.

See also:

Activating live view on page 51

50 Chapter 3—Shooting an image



Activating live view
Activate Leaf live view to view a live, video-like image of the view of
your camera's viewfinder.

Requirements:

This task assumes that you have established a connection between the
camera and Leaf Capture.

Leaf live view can be used with all Leaf digital camera backs, but not
with all cameras. For example, if you have a Mamiya® AFD or Contax,
the live view features are not available.

Note: Ensure that the Leaf live view dongle and the camera are
connected to your computer. Live view can only be activated when
supported cameras are connected. For information about connecting
the camera hardware to your computer, see the Leaf Aptus Installation
Guide.

Note: For Aptus users, to use live view you must have purchased the
live view dongle, and activate it by connecting to the camera, as
described here.

 This task is performed on the Shoot panel Live View area.

1. On the Live View area, click Play .
The live view appears in the preview area, and the live view features
are activated. You can now begin to use the Leaf live view functions.

Note: If there is too much light or too little light, the image does not
appear and the live view display area is blue. In this case, you should
adjust the light or live view exposure time.

2. To stop a live view image, click Stop .
When you stop the live view image, the live view functions become
unavailable.

See also:

Using Leaf live view on page 50

The image and preview areas on page 10
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Toggling live view color
Toggle between a color and black and white live view display.

For Leaf AFi, AFi-II, and Aptus-II, live view is available in color at full
picture size.

 This task is performed on the Shoot panel Live View tab.

Click the button  to toggle between black & white and color.

Note: When you zoom into live view, the preview is black and white.

Changing the live view exposure time
The Leaf live view exposure time feature enables you to adjust the
sensor's exposure time via the Leaf Capture software. Adjust the
exposure time to compensate for too much or too little light in the live
view image.

If you activate the live view but no picture is displayed and the live view
display area is blue there may be too much light or too little light.
Adjusting the exposure time can make the live view image appear.

 This task is performed on the Shoot panel Live View area.

In the Live View area, do one of the following:

● To decrease the amount of light click Decrease Live View

Exposure Time .
● To increase the amount of light click Increase Live View

Exposure Time .

Note: The greater the exposure time, the longer live view takes to
display the image.
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Composing with live view

You can use Leaf live view to compose a shot in the following ways:

● Use the layout overlay tool to show or hide an overlay
● Use the grid tool to place a grid over your image

See also:

Showing a grid over your image on page 15
Using the layout overlay tool on page 16

Focusing the live view image
Use the focus meter to help you focus the live view display.

See also:

Tips on live view on page 56

Using the focus meter

The focus meter measures focus by measuring the contrast in a
selected area. Use the focus meter as a visual aid to help you achieve
the best possible focus. The colors on the meter help you see the focus
measurements when you are standing at a distance from the monitor.

You can undock, resize, and flip the focus meter as desired.

 This task is performed on the Shoot panel Live View area.

1. In live view, zoom into the area of the shot that you want to be in focus.

2. Making manual adjustments, acheive the best possible focus visually.

3. Click the focus meter tool .

4. Click a point on the image that contains a transition in contrast and
on which you want to focus.

The focus meter appears in the Live View area.

The numbers displayed on the focus meter are 50/50. 50 is the
starting point for indicating whether or not the selected point is in
focus.
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The turquoise number represents the position of the best focus

indicator  on the meter. This number is the best focus achieved
since the current focus point was selected.

The green number indicates the position of the current focus reading.

5. Focus the lens.

● As the green bars approach the best focus indicator, the image is
becoming focused.

● As the green bars move away from the best focus indicator, the
image is becoming out of focus.

● When the green bars meet the best focus indicator, you have
achieved the best possible focus.

Note: Each time you click the image with the focus meter tool, the
point on the image is reset to 50/50 on the focus meter.

Moving the focus meter on the screen

 This task is performed on the Shoot panel Live View area.

1. To detach the focus meter, click  and select Detach Focus
Indicator.

2. Drag it to any location on the screen.

3. To dock the focus meter, click  and select Dock Focus Indicator.

Changing the focus meter orientation

For your convinience, change the orientation of the floating focus meter.

This task assumes that the focus meter is floating.

 This task is performed on the Shoot panel Live View area.

Click  and select Flip to horizontal.
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Using the gray balance picker (live view)
Use the Gray Balance Picker to neutralize the color live view display
according to a specific gray point.

 This task is performed on the Shoot panel Live View area.

1. Click the Gray Balance Picker tool .

2. On the image, move the pointer to a midtone area, and click.

The color display is neutralized.

Note: The neutralized display applies to the live view display only, and
not to subsequent images you take.

Using the depth of field preview
When you are using Leaf live view, the camera's aperture is fully
opened. Use the depth of field preview to close down the aperture to
the aperture set in the camera control area.

Note: This feature is available only when tethered to the Leaf AFi
camera system or the Rollei eShutter.

 This task is performed on the Shoot panel Live View tab.

1. Click Depth of Field Preview .
The camera aperture closes to the aperture set in the Camera
Control area.

2. To fully open the aperture click Depth of Field Preview again.

See also:

Setting the aperture on page 43
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Saving the live view image
Save your live view image and use it as a digital layout for future use.

 This task is performed on the Shoot panel Live View area.

1. In the Shoot panel Live View area, click Save Live View .
The Save Live View As dialog box opens.

2. Type a file name for the live view image and click Save.

The live view image is saved.

Tips on live view

Focus meter

For best focus results, select a high contrast area that is on a single
focal plane. Do not select the edge of an object with a more distant
object behind it.

See also:

Focusing the live view image on page 53
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4 Adjusting an image

The Adjust panel consists of tools and information that enable you to
evaluate, analyze, and edit your captured images.

The options in the Adjust panel tabs are active when a RAW image is
selected. The selected image is called the spotlight image. If you select
more than one image, the parameters displayed in each tab are those of
the spotlight image. If you change any parameter, the change applies
only to the spotlight image.

The changes you make to your image do not affect the RAW file; they
are saved alongside the RAW image data.

On the Adjust panel the Gray Balance, Develop Curve, and Sharpness
tabs have two working modes, standard and advanced:

Standard mode is designed for all users, particularly those taking their
first steps in digital photography. The tools in standard mode are
relatively simple and are sufficient for performing day-to-day work as a
photographer.

Advanced mode offers the same functions as standard mode, with
additional sophisticated tools for in-depth editing and fine-tuning.

You can optimize your screen for adjusting an image by customizing the
image area. We recommend you use a preview with thumbnails view.

About the Adjust panel
The Adjust panel consists of tools and information that enable you to
evaluate, analyze, and edit your captured images.

Gray balance
Achieve color balance by using the gray balance tools on the Adjust
panel Gray Balance tab.



When shooting with film, you correct light-source color bias and the
effects of film emulsion by using color correction filters. In digital
capture, you can achieve color balance by using the gray balance tools,
usually in combination with a gray surface in the scene.

Leaf Capture provides several predefined gray balance settings to suit
different camera backs and light conditions. Using a predefined gray
balance setting often provides satisfactory results. Alternatively, you
can customize predefined gray balance settings by using the pickers or
the Temperature and Tint sliders.

Predefined gray balance settings
Select a predefined gray balance setting on the Adjust panel Gray
Balance tab.

The gray balance predefined setting list contains factory settings to suit
different camera backs and light conditions. When you select a
predefined gray balance setting from the list, the temperature and tint
values for that setting are displayed in the color sliders.

If you alter a predefined setting, for example by using a gray balance
tool, the setting is labelled custom and can be saved.

See also:

The predefined setting list on page 29

Using the image gray balance picker (Adjust panel)
Use the Image Gray Balance Picker to neutralize an image according to
a specific gray point in the image prior to evaluating the image colors.

The Image Gray Balance Picker is useful for ensuring consistent and
predictable results in your work.

When you use the picker to click a gray point in your image-for
example, an 18% gray card in the shot-Leaf Capture makes this point
neutral, that is, the RGB values of the point become equal. The
remaining colors in the image are adjusted in relation to this point.

Note: For the most logical workflow, use the picker before using other
options.

 This task is performed on the Adjust panel Gray Balance tab.

1. Click the Image Gray Balance Picker tool .
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2. On the image, move the pointer to a midtone gray point (18%) that
you want to set as neutral, and click.

The Temperature and Tint sliders are reset according to the adjusted
neutral point. Adjust the sliders to restore cast, as desired.

If you wish to balance the highlights and shadows, use the advanced
gray balance tools.

Adjusting the temperature and tint
Use the Temperature and Tint sliders to fine-tune the cast of the
lighting to perfectly balance the image color.

You can compensate for unsatisfactory shot lighting by adjusting the
color temperature of the illumination of your image. Temperature and
tint are measured on the Kelvin scale.

 This task is performed on the Adjust panel Gray Balance tab.

1. First, set the gray balance with the image gray balance picker if
necessary.

Leaf Capture adjusts the Temperature and Tint sliders according to
the gray balance that you picked.

2. Move the Temperature slider to the desired color temperature:

● To compensate for a low color temperature (yellow), move the
slider to the left. The image colors become bluer.

● To compensate for a high color temperature (blue), move the
slider to the right. The image colors become more yellow.

3. Move the Tint slider to the desired tint:

● To compensate for a magenta cast, move the slider to the left.
The image colors become greener.

● To compensate for a green cast, move the slider to the right. The
image colors become more magenta.

Note: You can also set the color temperature by typing the desired
value.
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Achieving gray balance
Use the Shadow Gray Picker and Highlight Gray Picker tools in
conjunction with the Image Gray Balance Picker tool to achieve gray
balance by picking two end points and a midtone point.

 This task is performed on the Adjust panel Gray Balance tab in

advanced mode .

The Shadow Gray Picker and Highlight Gray Picker tools enable you to
achieve a neutral setting along the luminance axis. The Shadow Gray
Picker tool removes all cast color in the shadow areas and the
Highlight Gray Picker tool removes all cast color in the highlight areas.

1. Use the Image Gray Balance Picker tool  to create an overall
balance.

Note: If you use the Camera Gray Balance Picker tool after using
the Highlight or Shadow Gray Picker, all grays in the image are reset.

2. Select the Highlight Gray Picker tool , and pick a highlight spot
in the image.

3. Select the Shadow Gray Picker tool , and pick a shadow spot in
the image.

Setting gray balance for multiple images
Adjust the gray balance for several images at a time.

When you select more than one image, the predefined setting list shows:

● The common setting, if all the selected images were saved with the
same setting

● As tagged in File, if the setting of each image varies

If the settings of each image in the selected group varies the Shadow
Gray Picker and Highlight Gray Picker tools are unavailable.
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 This task is performed on the Adjust panel Gray Balance tab.

To make the pickers available, select a predefined setting in the list
in order to define a common setting for all the selected images.

See also:

The predefined setting list on page 29

Tips on gray balance

Check the R, G, and B values of a spot on your image.

When you adjust the gray balance it is useful to check the color values
of areas of your image and to control these values during the adjustment.

 This task is performed on the Adjust panel Gray Balance tab.

1. Make sure that the Pixel Info options are set to Output RGB/CMYK
values.

2. Using the Picker tool , pick a spot on the image that you would
like to check.

The RGB or CMYK output values are displayed in the Pixel Info on the
lower bar.

See also:

Pixel information on page 20

The develop curve
The Adjust panel Develop Curve tab contains additional automatic and
manual tools by which you can evaluate exposure and adjust the tone
of your image.

The develop curve is a digital replacement for the manipulations that
you can perform when developing analog film. As with analog film, you
can develop your image with more or less contrast using the push-and-
pull process.
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Assessing your captured image alongside the histogram in advanced
mode replaces the need for a light meter.

● In standard mode, Leaf Capture can create a develop curve
automatically and you can change the brightness and contrast levels
manually.

● In advanced mode, the histogram is a graphic representation of the
exposure data (pixels at each intensity level) in a captured image.
Use the advanced tools to control the tone of your image. Create
your own develop curve in alignment with the exposure data
histogram. Creating your own develop curve also enables you to
control the degree of highlight and shadow in your image.

The standard Develop Curve tab
Use the Develop Curve tab in standard mode to automatically create a
develop curve, and to change the brightness and contrast levels manually.

Predefined develop curve settings
The develop curve predefined setting list contains factory-set develop
curves that you can apply to an image to suit different processes and
light conditions.

When you select a predefined develop curve setting, the shape of the
develop curve changes accordingly.

 This task is performed on the Adjust panel Develop Curve tab.

In the predefined setting list, select the desired setting.
If you alter a predefined setting, for example by adjusting the
brightness or contrast, the setting is labelled custom and can be saved.

See also:

The predefined setting list on page 29
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Adjusting the develop curve automatically
When you adjust the develop curve using the Automatic Develop
Curve option, the current develop curve is modified according to the
characteristics of the captured image.

The curve that is created has reasonable contrast, keeping details in the
shadow and highlight areas. You can also automatically create a
develop curve on a selected (cropped) part of your image.

 This task is performed on the Adjust panel Develop Curve tab.

Click Automatic Develop Curve .

The develop curve is customized, and appears in the predefined setting
list and can be saved.

Note: The Automatic Develop Curve option can create good results if
your image is correctly exposed. If not, the image can look flat.

See also:

Cropping an image on page 14

Using the exposure alarms
Overexposed and underexposed areas in your image may lack image
detail and not respond well to digital processing. The exposure alarms
highlight the areas of the image that are either overexposed or
underexposed, and the values are marked on the histogram.

 This task is performed on the Shoot panel Exposure Evaluation
area and on the Adjust panel Develop Curve tab.

Click the Overexposure Alarm , the Underexposure Alarm

, or both.

A mask appears on the overexposed or underexposed areas of the
image.

If you are working in advanced mode, the overexposed or
underexposed areas are also indicated on the histogram.
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You can customize the color of the mask, the blinking of the mask, and
the overexposure and underexposure limit lines that appear on the
histogram.

See also:

About the histogram on page 48

Inverting the exposure alarms

Invert the exposure alarms to help you visually check the exposure of
your shot.

 This task can be performed on the Shoot panel Selected Shot
area or on the Adjust panel Develop Curve tab.

Click .

Setting the exposure alarm mask to blink

 This task can be performed on the Shoot panel Selected Shot
area and on the Adjust panel Develop Curve tab.

1. To access the exposure alarm tools, click , and select Over/
Under Alarms.
The Over/Under Alarms window appears.

2. Select Show blinking mask in image.
The mask blinks on the image.

Marking an exposure limit on the histogram

 This task can be performed on the Shoot panel Selected Shot
area or on the Adjust panel Develop Curve tab.

1. To access the exposure alarm tools, click , and select Over/
Under Alarms.

The Over/Under Alarms window appears.

2. Select Always show over/under limit on the histogram.

The appropriately-exposed areas of the image appear on the histogram
between the limit lines.

Underexposed areas are shown below the underexposure limit line;
overexposed areas are shown above the overexposure limit line.
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Setting the color of the exposure alarm mask

 This task can be performed on the Shoot panel Selected Shot
area and on the Adjust panel Develop Curve tab.

1. To access the exposure alarm tools, click , and select Over/
Under Alarms.
The Over/Under Alarms window appears.

2. In the Over and Under areas, click the colored box.
3. In the Over/Under Exposure Alarm Color dialog box, select the

desired color.
4. Click OK.

Adjusting the brightness and contrast
Set the brightness and contrast of your shot using the sliders.

The Brightness and Contrast options enable you to develop a captured
image in a way that is similar to push-and-pull processing in analog
photography. With the digital brightness and contrast controls, you can
experiment until you obtain the optimal result.

Changing the brightness is similar to increasing or decreasing
exposure, often referred to as exposure compensation.

Changing the contrast is similar to increasing or decreasing the
exposure range of the film, resulting in lesser or greater contrast.

The brightness and contrast controls are not limited to ±0.5 f-stops.
Nevertheless, drastic changes in brightness and contrast may not
produce the desired results. To achieve the best possible image quality,
use your lighting system to create the proper exposure, and use the
Brightness and Contrast options only for making fine adjustments.

 This task is performed on the Adjust panel Develop Curve tab.

Type the desired value in the Brightness or Contrast value box or
move the Brightness or Contrast slider as desired.

Advanced develop curve tools
In advanced mode, a histogram showing a five-point develop curve is
displayed on the Adjust panel Develop Curve tab. The histogram and
related tools enable you to control the exposure of the image.

Using the develop curve shown in the histogram, you can control the
tone of the image. You can also create your own develop curve
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according to the exposure data histogram. Creating your own develop
curve enables you to control the degree of highlight and shadow in your
image.
See also:
About the histogram on page 48

The advanced Develop Curve tab

In advanced mode, a histogram showing a five-point develop curve and
related tools enable you to control the exposure of the image.

About the histogram

Use the histogram in the Shoot panel Exposure Evaluation area and in

the Adjust panel Develop Curve tab advanced mode  to evaluate
the lighting of your shot.

The histogram is a graphic representation of the exposure data (pixels
at each intensity level) in a captured image displaying the overall pixel
distribution of the image.

The histogram is read via the x-axis, which is a scale of f-stop values
ranging from +3 f-stops to -8 f-stops. These numbers represent the
relative exposure of the image in f-stops. Zero is the f-stop at the
midpoint of the scale and is equivalent to an 18% reflectance value. The
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width of the histogram represents the range of f-stops in the image. A
shaded area above the x-axis represents the distribution of pixels at the
different exposure levels in the image in terms of highlight, shadow, and
midtone values.

You can use the histogram to view changes that you make to the
exposure and the lighting of the scene. For example, by looking at the
histogram, you can determine whether your image is flat, and how
much catchlight area you have captured. You can then make exposure
or lighting adjustments and view the adjustments in the image-in one
of the display windows, and for a more accurate view, via the data in
the histogram.

The histogram enables you to quantitatively assess your image in terms
of exposure. It is a tool that you can use continually throughout your
photo session, to verify that your shots are correctly exposed. The
position of the histogram on the horizontal axis reflects exposure of the
image. Images with effective lighting contrast have a histogram that
spans the lightest to the darkest point.

A properly exposed image has a highlight area that falls in the
histogram at around +2 f-stops, leaving an adequate range of between
+2 and +3 f-stops for any bright or shiny elements (such as catchlight)
in the image.

The Histrogram Channel list enables you to display the histogram of
each color channel:

● L L for luminance. Select L to check the overall exposure.
● R for the red channel
● G for the green channel
● B for the blue channel
● A for all channels. Select A to show both the overall exposure and

the distribution of red, green, and blue light levels in the image. Use
this view to check that the highlight points in brightly colored
objects are not overexposed.

 The picker tool provides an indication of the relative exposure (in f-
stops) of the selected spot on the histogram.

If the selected point is black and white, the histogram displays one
black line, at the relative exposure value point on the x-axis.

Lines are displayed on the histogram to mark the overexposed and
underexposed limits. If the selected point is a colored point, the
histogram displays the following lines:

● A short red line representing the red channel of the spot
● A short green line representing the green channel of the spot
● A short blue line representing the blue channel of the spot
● A black line represents the lightness value that the spot would have

if it were neutral
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A mask is displayed on the histogram when the overexposure and
underexposure alarms are on.

See also:

Using the exposure alarms on page 47
Advanced develop curve tools on page 65
Detaching the histogram on page 90

Adjusting the develop curve

 This task is performed on the Adjust panel Develop Curve tab,

in advanced mode .

Adjust the points on the develop curve by doing the following:

● While pressing the Alt key drag one of the five points to the
desired position. You can save the new develop curve and update
the camera settings.

● To move the shadow or highlight point while maintaining the
shape of the curve drag the end point to the desired location. All
points in the curve are adjusted except the opposing end point.

● To move any of the midpoints without moving the end points
drag the midpoint to the desired location. All points in the curve
are adjusted except the end points.

Tip: You can click any point and then use the keyboard arrows to
move it.

Manipulating the develop curve

The develop curve histogram is available in advanced mode on the
Adjust panel Develop Curve tab.

The develop curve is a graphical representation of the mapping
between the 16-bit capture data and the 8-bit output data. The curve
displayed on the histogram enables you to map the relationship
between the capture data and the output data.

The horizontal axis represents the light values in the scene, from
shadows to highlights. The vertical axis represents the light values on
the monitor (or the ink values in print) in sv units (system values)
representing output intensity. The curve behaves in a similar way to a
film characteristic curve, translating scene exposure to film density.

Manipulating the develop curve is the digital equivalent of
manipulating the processing film in your development lab. As with
analog film, you can develop your image with more or less contrast
using the push-and-pull process.
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Simple predefined curves offer a variety of ‘films’ and developing
processes, allowing you to control the result on the display.

The develop curve has five control points, each of which represents a
different level of brightness and contrast.

● Shadow point-Represented by the black dot on the develop curve.
This point indicates the darkest value at which you still see texture
and detail in the output image. Pixels with values smaller than the
value of the shadow point lose detail.

Note: To achieve good results, adjust the lighting and exposure
before manipulating the develop curve. Use the develop curve to
make small adjustments to enhance your captured image. As in
analog photography, first ensure that you have the best exposure,
and then choose the development process if you wish to change the
resulting image. The recommended output value for areas with
darkest shadow detail is greater than 10 sv.

● 3/4 tone point-The midpoint between the shadow point and the
midtone point.

● Midtone point-Represented by the gray dot on the develop curve.
This point controls the contrast and brightness in the parts of the
image between the shadow and highlight points. By moving the
midtone point left or right you can make the midtone values darker
or lighter. For an ideal exposure, the midtone output value for an
18% gray card should be 127 sv.

● 1/4 tone point-The midpoint between the midtone point and the
highlight point.

● Highlight point- Represented by the white dot on the develop curve.
This point indicates the brightest value at which you still see texture
and detail in the output image. Pixels with values greater than the
value of the highlight point lose detail. The recommended output
value for areas with the brightest highlight detail is less than 248 sv.
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Defining the highlight and shadow points

The Highlight Point Picker and Shadow Point Picker tools enable you
to select a point in your image to set as the shadow or highlight point of
the develop curve.

 This task is performed on the Adjust panel Develop Curve tab,

in advanced mode .

1. Click the Highlight Point Picker tool  or Shadow Point Picker

tool .

2. Click a point in your image that you want to be the highlight or
shadow of your image.

The end point in the histogram adjusts according to the values of the
point picked. The point is given the default system value for shadow or
highlight.

Tip: The highlight and shadow points are critical for producing high
quality offset prints. The highlight point is related to the smallest
amount of ink that the printer can apply to the paper, and the shadow
point is related to the greatest amount of effectively printable ink. If you
are printing to offset, you should obtain the optimal values for these
points from your printer.

Adjusting the develop curve for multiple images
Adjust the develop curve for multiple images at the same time on the
Adjust panel Develop Curve tab.

You can adjust one or more images at a time. However, if more than
one image is selected, the following features are not available:

● Overexposure and underexposure alarms
● Highlight and shadow pickers

When you select more than one image and the settings in each image
vary the predefined setting list shows As tagged in File.

If As tagged in File appears, you can make the unavailable features
available by applying one setting from the predefined settings list to all
the images within the group.

See also:

The predefined setting list on page 29
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Tips on the develop curve

The Adjust panel Develop Curve tab contains additional automatic and
manual tools by which you can evaluate exposure and adjust the tone
of your image.

The develop curve

Use the develop curves provided for images that suit the curves'
dynamic ranges. Usually, setting your lighting to an appropriate fixed
develop curve is preferable to correcting the curve to suit your lighting.

The auto-develop curve

The Automatic Develop Curve option can be very useful when applied
to uncontrolled lighting situations, since the default, factory-set curves
are created for specific dynamic range images. The Automatic Develop
Curve option automatically “pushes” the more detail-rich areas of the
image.

The Automatic Develop Curve option provides a good result only if the
image is exposed correctly. If not, the image can look noisy or flat.

The histogram

If the histogram shows a lack of sufficient light, take the shot again at a
better exposure. Underexposed images do not respond well to
subsequent digital processing.

Using the histogram with the crop tool

If you crop a specific area of the image with the crop tool, the
histogram displays the data of this area.

Using the histogram with the picker tool

The picker tool indicates the relative exposure of the selected spot on
the histogram. If you require specific points in the captured image to
include detail, they must be appropriately exposed. Using the picker
tool you can control into which exposure zone each point falls so that
you will obtain the results that you require.

Using the develop curve with the picker tool

The picker tool enables you to easily calculate the exposure ratio
between the highlight and shadow areas of the image. In most cases,
the ideal value for the brightest areas in the image detail is
approximately +2 f-stops, between 240 to 248 sv (system values) in
Capture RGB (8-bit) color.
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The exposure alarms

Choose a color for your exposure alarms that differs from the dominant
colors of your captured image. An appropriate choice can help you
avoid confusion between the highlighting color mask and your image
data.

The develop curve and highlight/shadow pickers

The shadow and highlight points are critical for producing high-quality
offset prints. The highlight point is related to the smallest amount of ink
that the printer can apply to the paper, and the shadow point is related
to the greatest amount of effectively printable ink. If you are printing to
offset, you should obtain the optimal values for these points from your
printer.

See also:

Adjusting the develop curve automatically on page 63
Using the picker tool on page 18
Cropping an image on page 14

About color
You can maintain color quality in your images by using ICC color
management on the Adjust panel Color tab.

The International Color Consortium® (ICC) was established by industry
vendors for the purpose of creating, promoting, and encouraging the
standardization and evolution of an open, vendor-neutral, cross-
platform color management system architecture and components. The
ICC profile is a color space description that acts as a standard for
accurate reproduction of colors across different platforms, devices, and
software.

In Leaf Capture, the color management system uses the following
profiles:

● Input device profile: provides the color management system with
information about the colors the Leaf digital camera back is capable
of capturing. On the Color tab, you can select and adjust the
saturation of an input profile.

● Display device profile: provides the color management system with
information about the display device colors, enabling your monitor
to display the actual colors in your images.

Note: Before you begin working with Leaf Capture, you should
create and designate a display device profile for your monitor using
the ColorSync Utility.

When working with color management in Leaf Capture, the color
management system takes the input device profile and converts it to a
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universal color standard. It then converts the universal color standard
to the display device profile colors. The perceived colors are maintained
throughout.

See also:

Viewing shots in the preview monitor on page 90

Disabling color management
If desired, you can work without color management. This is usually
required when you create a color target for a profile creation program.
Without color management, the output file for the image in an RGB file
that conforms to the camera RGB color space.

 This task is performed on the Adjust panel Color tab.

Clear the Color Management check box.

Color management is not used in creating the output file of the image.

Note: It is recommended that you re-enable color management
once you have created your input profile.

Choosing a color profile

 This task is performed on the Adjust panel Color tab.

There are several factory-set profiles. Choose the input profile that best
matches the scene, lighting conditions, output destination, and your
own preference.

In the Color Look list, select a camera profile.

The colors of the image adjust to comply with the parameters of the
camera profile.

Creating a color profile

 This task is performed on the Adjust panel Color tab.

Notes:
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● This feature is available in the Leaf Custom Color Profiling module,
which must be purchased separately. For more information, see your
Leaf dealer.

● Custom color profiling is currently only supported on Mac®.

1. Shoot a GretagMacbeth® SG (10x14 patches) target with the Aptus
22 Product (standard) camera setting and the photographic lighting
that will be used.

2. On the Gray Balance tab select the Image Gray Balance Picker.

3. Click a middle gray patch anywhere in the target, for example I5.

4. Ensure that the exposure is correct and uniform:

a. To test the exposure, place the pointer on a white patch on the
image, and in the Pixel Info box, check that the system value is
between 210 and 250.

b. To verify the uniformity, place the pointer on each remaining
white patch and verify that each system value does not vary
more than 5 points from the system value in the previous step.

If either of the above conditions are not satisfied, make the
required adjustments and shoot the target again.

5. Check that the patches in your image are straight and that the target
is positioned parallel to the camera back using the grid. If the
patches are not straight, or the lines are not parallel, straighten the
test chart and take the shot again.

6. Clear the Color Management checkbox.

7. Click Create Profile.
The ProfileMaker software opens with the image of the target.

8. Use ProfileMaker to create a color profile. For assistance, refer to
the ProfileMaker help system. The profile that you create must be
saved in one of the ColorSync Utility profile folders. We recommend
that you save it in the Library > Colorsync > Profiles folder in your
own user folder.

9. Select the Color Management checkbox.

10. In the Color Look list, select the new ICC profile.

Note: It may take a few moments for the new profile to appear in the
Color Look list.

Editing a color profile
Edit an existing color profile using one image or a number of images in
the ProfileEditor software.

Note: Custom color profiling is currently only supported on
Macintosh®.
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 This task can be performed on the Adjust panel or Process
panel Color tabs.

1. Select an image with the color profile that you want to edit.

Note: You can work on only one image at a time in the ProfileEditor.
If you select more than one image, it is the spotlight image that
opens in the ProfileEditor software.

2. In the Color Look / Color Space list, select a color profile.

3. Click Edit Profile.
ProfileEditor opens with the image that you selected.

4. Use ProfileEditor to edit the color profile. Ensure that P (Perceptual)
intent is selected before you edit your profile. For assistance, refer to
the ProfileEditor help files.

If you do not want to use more images to edit the profile, go to step
13.

5. In Leaf Capture, select all further images you wish to use.

6. On the Process tab > Format box, ensure that either a TIFF (8bit) or
JPEG file format is selected.

7. In the Color Space list select Camera RGB.

8. Click Send to Process queue .

9. In the ProfileEditor software, close the image that is currently open.

10. Click Open Image, navigate to the Leaf Capture Processed folder,
and select the next image you wish to use.

11. Use ProfileEditor to continue editing the color profile.

12. Repeat steps 9-11 for every additional image that you want to use.

13. If you create a new profile, the profile must be saved in one of the
Macintosh ColorSync Utility profile folders before you can work with
it in Leaf Capture. We recommend that you save it in the Library /
Colorsync / Profiles folder in your own user folder.
The new or edited profile appears in the Color Look list.

Note: It may take a few moments to appear in the list.

14. In the Color Space list, select the edited color profile.
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Adjusting the color saturation
Set the color saturation for your shot.

 This task is performed on the Adjust panel Color tab.

Slide the saturation slider or select a predefined setting from the list.

Adjusting color for multiple images (Adjust panel)
Adjust the color of multiple images at the same time on the Adjust
panel Color tab.

When you select more than one image and the settings in each image
vary, the predefined setting list shows As tagged in File.

If As tagged in File appears in the Color Look list, you can select an
input profile from the list to apply to all selected images.

If As tagged in File appears in the Saturation list, the position of the
slider reflects the saturation of the spotlight image. Select a saturation
table from the list or adjust the slider to apply the same saturation to all
the selected images.

See also:

The predefined setting list on page 29

Tips on color for adjusting

To view color according to a color profile, ensure that your monitor is
calibrated. Calibrate your monitor using the system software. The
name of the monitor's current color profile appears on the Adjust panel
Color tab next to the word Monitor.

Note: You can change the monitor profile in ColorSync Utility.

Leaf Capture provides several input profiles. If you want a profile that is
unique to your working environment and camera back, create a new
color profile or edit an existing profile.

To view the effects of different color profiles on your image, work with
your image in Preview mode and monitor the Pixel Info panel on the
lower bar.
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Using filters
Use the Adjust panel Filter tab to adjust the amount of grain and
reduce moire in an image. Whether or not you need to select a filter
depends on the ISO, exposure time, and the subject of your shot.

About noise

The amount of noise in your image is directly related to the ISO speed
you use when taking the shot. A high ISO speed always results in more
noise.

Leaf Capture provides you with default noise settings, and also enables
you to adjust the noise as desired so that you can save and reuse your
own noise settings.

The noise reduction tools are available on the Adjust panel Filter tab.

Predefined noise settings

The noise predefined setting list contains factory-set noise settings
that you can apply to an image to suit different conditions. When you
select a predefined noise setting, the noise settings are updated
automatically.

 This task is performed on the Adjust panel Filter tab, in the
Grain area.

In the predefined setting list, select the desired setting.

If you alter a predefined setting, the setting is labelled custom and can
be saved.

See also:

The predefined setting list on page 29

Adjusting the noise

 This task is performed on the Adjust panel Filter tab, in the
Grain area.

1. Ensure that the Detail pane is open, or that the preview is zoomed at
1:1, so that you can view the changes that you make to the image.
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2. Move the Strength slider to adjust the amount of noise, or select a
setting from the predefined setting list.

See also:

Opening the Detail pane on page 8

Cleaning long exposure

Remove undesired noise throughout your image.

 This task is performed on the Adjust panel Filter tab, in the
Grain area.

When shooting with an exposure of longer than one second, unwanted
colored pixels can appear in your shot. Use the Clean long exposure
check box to remove unwanted effects in your image.

1. Ensure that the Detail pane is open, or that the preview is zoomed at
1:1, so that you can view the changes that you make to the image.

2. Select the Clean long exposure check box.

The shot is cleaned of noise. After using the clean filter, you can use
the strength slider to perform fine adjustments on the noise.

Note: When you saving your settings, the grain and long exposure
time are saved under the same name.

See also:

Opening the Detail pane on page 8
Adjusting the noise on page 77

Reducing noise for multiple images

When you select more than one image and the settings in each image
vary, the predefined setting list shows As tagged in File.

If As tagged in File appears, you can make the features that currently
do not work available by applying one setting to all the images within
the group.

 This task is performed on the Adjust panel Filter tab, in the
Grain area.

From the predefined setting list, select a setting.

See also:

The predefined setting list on page 29

78 Chapter 4—Adjusting an image



Tips on reducing noise

 This task is performed on the Adjust panel Filter tab, in the
Grain area.

To avoid unwanted noise, make sure that your images are properly
exposed.

About moire

Leaf Capture enables you to reduce moire patterns in your image. You
can reduce the moire over the entire image or only in selected areas of
the image.

The moire reduction tools are located on the Adjust panel Filter tab.

Note: Reducing moire over the entire image can cause color correction
in unwanted areas.

Predefined moire settings

The moire predefined setting list contains factory-set develop curves
that you can apply to an image to suit different conditions.

 This task is performed on the Adjust panel Filter tab, in the
Moire Reduction area.

In the predefined setting list, select the desired setting.

If you alter a predefined setting, the setting is labelled custom and can
be saved.

See also:

The predefined setting list on page 29

Reducing moire in specific areas

 This task is performed on the Adjust panel Filter tab, in the
Moire Reduction area.

1. Ensure that the Detail pane is opened.

2. Click Selective.
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3. Select a pixel selection tool .

4. In the preview area, use the pixel selection tool to create a contour
of the area to be treated.

5. Select the Preview check box to see the change displayed in the
preview area.

6. Adjust the Radius and Strength sliders.

7. View the reduction in the moire in the Detail pane. If you are
working in a zoom ratio that is greater than 66.7%, you can view the
adjustments in the preview area.

8. Click Save if you wish to keep your adjustments.

Before Leaf Capture saves the image, it asks if you would like to save
a copy. Because any changes that you make are made to the original
image, it is recommended that you save a copy of the image.

Tip: After you achieve the desired reduction in moire in one area of the
image, it is recommended that you clear the Preview checkbox before
continuing to select other areas for moire reduction. This will help you
work quicker.

See also:

Pixel information on page 20
Pixel selection tools on page 80
Opening the Detail pane on page 8

Pixel selection tools

 This task is performed on the Adjust panel Filter tab, in the
Moire Reduction area.

1. From the tool box , click the tool that you
want to use:

● Ellipse Marquee  - this tool creates an oval shaped selection
of pixels.

● Rectangle Marquee  - this tool creates a rectangular shaped
selection of pixels.
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● Polygonal Lasso  - this tool creates a selection of pixels from
straight lines.

● Lasso  - this tool enables you to control the shape of the
selection.

2. In the preview area, click the image and drag the cursor to select the
pixels.   

Tip: Press Shift and Alt for extra options.

See also:

Opening the Detail pane on page 8

Reducing moire over the entire image

Reduce the moire over the entire image.

 This task is performed on the Adjust panel Filter tab, in the
Moire Reduction area.

1. Ensure that the Detail pane is open so that you can view the
changes you make to the image.

2. Click Global.

3. Move the Radius and Strength sliders until you see the desired
effect in the Detail pane, or select a setting from the predefined
setting list.

4. View the reduction in the moire in the Detail pane. If you are
working in a zoom ratio that is greater than 66.7%, you can view the
adjustments in the preview area.

See also:

Opening the Detail pane on page 8

Reducing moire for multiple images

When you select more than one image and the settings in each image
vary, the predefined setting list shows As tagged in File.

If As tagged in File appears, you can make the features that currently
do not work available by applying one setting to all the images within
the group.
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 This task is performed on the Adjust panel Filter tab, in the
Moire Reduction area.

From the predefined setting list, select a setting.

The predefined settings apply to global moire reduction only.

See also:

The predefined setting list on page 29

About sharpening an image

Most images can benefit from sharpening. The degree of sharpening
needed varies depending on the image subject and its output.

The sharpening tools are available on the Adjust panel Sharpness tab.

Sharpening enhances the definition of the edges in an image. The
sharpening process sharpens the borders of adjoining areas of different
levels of brightness. A very thin contour of a lighter and darker strip
emphasizes the border between different-colored objects.

Note: Sharpening cannot correct a severely blurred image.

Digital images typically need some sharpness adjustment to provide
the desired results in print or other output, especially after rescaling. To
maintain image sharpness, you should increase the sharpness every
time you increase the scale.

The sharpness tools enable you to sharpen edges in your image
without increasing the noise.

Use the Detail pane to see the affects on the image as you adjust the
sharpness.

See also:

Opening the Detail pane on page 8

Predefined sharpness settings
The sharpness predefined setting list contains factory-set settings that
you can apply to an image to suit different types of images and
subjects. When you select a predefined sharpness setting, the
sharpness parameters change accordingly. When a parameter is
manually adjusted, the setting becomes custom and can be saved.
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 This task is performed on the Adjust panel Sharpness tab.

In the predefined setting list, select the desired setting.

If you alter a predefined setting, the setting is labelled custom and can
be saved.

See also:

The predefined setting list on page 29

Setting the radius

The radius refers to the thickness of the outline created in the
sharpening process. The larger the radius, the thicker the outline. Set
the radius in relation to the scale of your image. The radius then serves
as the basis by which you set the other sharp parameters.

 This task is performed on the Adjust panel Sharpness tab.

Do one of the following:

● In the Radius value box, enter the desired value.
● Move the Radius slider as desired.

Note: You can also set the radius in advanced mode.

See also:

Advanced sharpening tools on page 84

Setting the intensity
Use the intensity slider to select the degree of lightning or darkening of
the pixels. The greater the intensity, the larger the contrast between
different colored areas.

Sharpness is achieved by comparing the light intensity of a pixel to its
surrounding area and modifying the pixel accordingly. If the pixel is
darker than its surrounding area, it is darkened even more to achieve a
sharper contrast. If the pixel is lighter than its surrounding area, it is
lightened even more. If the pixel's light intensity is the same as its
surrounding area, no action is taken.

 This task is performed on the Adjust panel Sharpness tab.
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Note: Set the intensity first if the image is not scaled.

Move the Intensity slider as desired.

Note: You can also set the intensity in advanced mode.

See also:

Setting the highlight and shadow intensity on page 85

Smoothing an image
Use the smooth tool to smoothen the effects of sharpening on areas of
minimal details, such as skin tone, that would otherwise acquire a
grainy look.

Increasing the sharpness of an image increases the amount of grain in
the image’s appearance.

The smooth tool reduced grain by decreasing sharpness according to
the nature of the surrounding area. Flat areas are greatly reduced;
texture and edges are not.

 This task is performed on the Adjust panel Sharpness tab.

Move the Smooth slider as desired.

Note: You can also set the smoothness in advanced mode.

Advanced sharpening tools
The advanced sharpening tools enable you to perform precise
sharpening on your image, according to the image characteristics, scale
and output.

Advanced sharpening tools are available in advanced mode  on the
Adjust panel Sharpness tab.

You can set the following in advanced mode:

● Adjust the Radius (as in standard mode)
● Pick a color filter by which to sharpen the image
● Control the intensity of your image in the highlights and shadows
● Control the grain strength and threshold

See also:

Setting the radius on page 83
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Filtering the image

Use the Filter tool to specify a color channel for Leaf Capture to use as
a reference for sharpening all the remaining color channels.

Single color filters (Red, Green, or Blue) result in some colors being
sharpened, while All sharpens all colors. When using a single color
filter,all the RGB channels are sharpened according to the variations in
that channel.

If the image contains a specific dominant color, or if a specific element
needs to be emphasized, use the corresponding color filter.

 This task is performed on the Adjust panel Sharpness tab, in

advanced mode .

In the Filter list, select a color filter.

Setting the highlight and shadow intensity

The intensity tool enables you to adjust the intensity level of the
highlights and shadows separately, according to the characteristics of
the image.

 This task is performed on the Adjust panel Sharpness tab, in

advanced mode .

Select the desired intensity level in the Highlight and Shadow lists.

See also:

Setting the intensity on page 83

Controlling the grain strength

In advanced mode, determine the smoothness of the image by using
the strength and threshold tools.

Strength refers to the sharpness of the grain in uniform areas. The
strength scale ranges from 0, which is grainy, to 10, which is smooth.

 This task is performed on the Adjust panel Sharpness tab, in

advanced mode .

In the Strength list, select the strength of grain.
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Controlling the threshold

Determine the smoothness of the image by using the strength and
threshold tools.

Threshold refers to the amount of sharpness reduction performed on
the grain area. The threshold scale ranges from 0, which means that
the whole image is sharpened, including the grain in uniform areas, to
10, which means that Leaf Capture sharpens the image in more
detailed areas, and less in uniform areas.

 This task is performed on the Adjust panel Sharpness tab, in

advanced mode .

In the Threshold list, select the desired threshold value.

Adjusting sharpness for multiple images
Adjust the sharpness of multiple images at the same time on the
Adjust panel Sharpness tab.

You can adjust one image or more images at a time. When you select
more than one image and the settings in each image vary, the
predefined setting list shows As tagged in File.

If As tagged in File appears, you can make the features that currently
do not work available by applying one setting from the predefined
settings group to all the images within the group.

See also:

The predefined setting list on page 29

Tips on sharpening
Sharpen your image using the tools on the Adjust panel Sharpness tab.

Radius

Use a smaller radius for portrait photography than you would for still
life. A smaller radius gives you a smoother level of sharpness.

Highlight and shadow intensity

For images with a high dynamic range, the Highlight and Shadow
settings should both be set to the same level.
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For low-key images, increase the Highlight level more than the Shadow
level.

For high-key images, increase the Shadow level more than the
Highlight level.

Filters

When you select a specific color as a reference, some colors do not get
sharpened. If you want to sharpen all colors according to their
individual brightness variations, select All.

For most images, the Green filter creates a pleasing enhancement.
Portrait images may be improved using the Red filter. Use the All or Red-
Green filters for multi-colored images containing many details.
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5 Editing an image

This section presents the tasks you will perform while editing your
images at different stages of your workflow. The tools used for editing
are located on the editing toolbar.

The Shooting while editing section describes how you or your assistant
can edit images while you are shooting.

The Editing section discusses the actions you will perform to manage
and assess your images.

The Processing while editing section presents the workflow for
preparing and editing your images for processing.

Tip: Access the Browse panel and browse to the folder that contains
your images. Edit the images directly from the folder.

Shooting while editing
It is possible for you to shoot images while your assistant edits your
previous shots. This section describes tools and tips for this workflow.

See also:

Taking shots overview on page 33

Shooting and editing concurrently
Set the behaviour of incoming shots.

In tethered mode, every new shot is automatically selected and
becomes the spotlight image shown in the preview area. Leaf Capture
supports a workflow where you can continue shooting while your
assistant edits your images.

 This task is performed on the Shoot panel.

From the View menu select Do not select new shots.

See also:

Preparing to shoot on page 35
Taking a shot on page 45
Evaluating a shot on page 46



Viewing shots in the preview monitor
Open the preview monitor to view either each new shot or the spotlight
image on a second window or screen.

From the Windows menu select Preview Monitor.

If desired, you can drag the preview monitor to a second screen.

Tip: You can specify what appears on the preview monitor. From the
View menu, select Preview Monitor, and then click the required
option.

Note: If you are using two screens with different monitor ICC
profiles, the color displayed on both monitors is set according to the
ICC profile of the monitor that shows where the Leaf Capture
software is open. The name of this ICC profile appears on the Color
tab on the Adjust panel. To control which monitor provides color
accuracy, you can change the monitor that displays the open Leaf
Capture software.

See also:

Changing the monitor that displays Leaf Capture on page 90

About color on page 72

Changing the monitor that displays Leaf Capture

 If you have more than one monitor you can choose which monitor
displays Leaf Capture.

1. Close the Leaf Capture software.

2. Go to System Preferences > Displays.

3. Click the Arrangement tab.

4. Click the white strip on the image and drag it to your second monitor.

5. Restart the Leaf Capture software.

Detaching the histogram
The histogram is displayed in the Selected Shot area, but can be
etached to become a floating panel for convenience. This can be
especially useful when you are viewing your image in the preview monitor.
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 This task is performed on the Shoot panel Selected Shot area.

Click  and select Detach Histogram Panel or Dock Histogram
Panel.

See also:

About the histogram on page 48

Editing
This section discusses the actions you will perform to manage and
assess your images.

Assessing your images
Use the following to help you assess your images:

For focus:

● Use the Detail pane
● Use the loupe tool

For navigation:

● Pan
● Zoom

Customize the view in the image area to review your images.

Compare your images using compare view to choose the best shot.

See also:

Opening the Detail pane on page 8
Using the loupe tool on page 17
The editing toolbar on page 12
Using the zoom tool on page 14
The main toolbar on page 4
Comparing your images on page 91

Comparing your images
Use compare view to evaluate your images and to find your best shot in
a series by comparing them to one another.

In compare view, as in all other views, you can edit your images using
the Adjust panel tools and using the editing toolbar. You can select and
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remove images that you wish to compare as a group or one by one
using the familiar selection keys. You can open as many images as you
want to compare. Each image has full preview functionality, meaning
that you can compare images using the Leaf Capture tools—for
example, by checking the focus of each image using the loupe tool.

When you compare two images, one is the master image and the
second is the candidate. The master image (in a black frame) is frozen,
and the candidate image (in a green frame) is dynamic. You can change
which image is displayed in the candidate frame as you select other
images or flip through the images in the folder.

If you find a candidate image that you prefer to the master image, you
can set the candidate as the master image, and continue flipping
though the images in the folder.

Comparing two images

Compare two images to find your best shot in a series using a process
of elimination.

 This task is performed in compare view.

1. Click  to open compare view.

Compare view becomes the view mode in the image area. The
preview pane is the area where you compare your images. There is
also a thumbnails strip which displays all of the images in your
folder, as with other views. The thumbnails are displayed horizontal
or vertical according to the last selected preview with horizontal or
vertical thumbnails view.

Tip: Press the tab key to toggle the compare view size between the
regular image area size and the size of the entire workspace.

2. Select two images for comparison by holding down Cmd, and then
clicking the desired images in the thumbnails strip.
The selected images appear in the preview area in an arrangement
that optimizes their display size. The first image that you select is
the candidate image, and has a green frame. The second image that
you click is the master image, and has a black frame.

3. Compare and evaluate your images.

4. To toggle between the candidate and master images, click the
master image (the image in the black frame) in the preview pane.
The selected image becomes the candidate image and has a green
frame; the second image becomes the master image and has a black
frame.
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5. You can replace the candidate image in one of the following ways:

● To select a specific image from the thumbnails, hold down Alt,
and click the desired image. The selected image replaces the
candidate image in the preview pane.

● To flip through the images in your folder, hold down Alt, and use
the arrow keys. As you flip through the images in the folder, the
selected image replaces the candidate image in the preview pane.

As you flip through the images in the folder, compare them to the
master image. If you find an image that you like better than the master
image, you can set it as the master image. It then replaces the master
image, and you can continue to flip through the images in the folder.

Setting the candidate image as master

Switch the desingation of candidate and master image.

In compare view, as you flip through the images in the folder, compare
them to the master image. If you find an image that you like better than
the master image, you can set it as the master image. It then replaces
the master image, and you can continue to flip through the images in
the folder.

 This task is performed in compare view.

To set the candidate image as the master image click .

The candidate image is set as the master image. The new candidate
image is then the next consecutive image in the folder.

Adding an image to the compare pane

Compare two or more images in compare view.

 This task is performed compare view.

1. Hold down Cmd, and click the desired image in the thumbnails strip.

2. Continuing to hold down Cmd, continue to click as many images as
you want in order to add them to the preview area for comparison.

Removing an image from the compare pane

 This task is performed in compare view.

1. Hold down Cmd, and click the desired image in the preview pane or
thumbnails strip.
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2. Continuing to hold down the Cmd, continue to click as many images
as you want to remove from the preview area.

Replacing an image in a multiple selection

When comparing multiple images, you can replace one image in the
preview pane.

 This task is performed in compare view.

1. In the preview pane, click the image that you want to replace.
The image has a green frame.

2. Do one of the following:

● To select a specific image from the thumbnails, hold down ALT,
and click the desired image.

● To flip through images, hold down ALT, and use the arrow keys.

The image is replaced by the selected image, or by each image as you
flip through the images in the folder.

Synchronizing images in compare view

Synchronize your images to evaluate the same spot on different images.

Match the zoom and pan of all the images in compare view to the same
relative location as the spotlight image.

 This task is performed in compare view.

1. Zoom into or pan a zoomed spotlight image to an area of the image
you want to compare to other images.

2. Click Match all with spotlight image .
All the images in compare view show the same zoom and relative
location as the spotlight image.

Panning and zooming mulitple images in compare view

Pan or zoom all the images in compare view together with the spotlight
image.

 This task is performed in compare view.

1. Click Move all with spotlight image .
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2. Pan or zoom the spotlight image.
The rest of the images in compare view are panned or zoomed to
the same relative location in the image.

Refreshing the layout in the compare pane

After you remove images from the preview pane, you can refresh the
layout so that the images are reordered in series in the preview pane.

 This task is performed in compare view.

From the View menu select Compare Actions > Refresh Layout.

The images appear in the preview pane in an arrangement that
optimizes their display size.

Rotating an image

1. Select the image that you want to rotate.

2. From the Image menu, select Rotate and then select the desired
option.

See also:

Opening a folder or image on page 25

Flagging images

Flags are useful tools for tagging your images. For example, use flags to:

● classify images according to an order
● note preferences
● select a series of images that you wish to sort and then move

collectively to a different folder

● Flag an image or group of images
● Remove a flag
● Change the flag color

Note: When the Flag tool is selected, you cannot use the mouse to
select images in the thumbnails. If you wish to select images while
using the flag tool, press Alt and select the desired images.

See also:

The editing toolbar on page 12
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Flagging an image

1. Select the image or a group of images that you want to flag.

2. From the editing toolbar, select the desired flag     .

3. Do one of the following:

● To flag an individual image, click on the individual image.
● To flag a group of images, hold down Alt and Shift and click any

image in the selected group.

Note: After an image is flagged, the image is automatically saved with
the flag.

Removing a flag

1. Select the image or a group of images from which you wish to
remove the flag.

2. From the editing toolbar, select the flag that you wish to remove
from the image.

3. Do one of the following:

● To remove the flag from an individual image, click on the
individual image.

● To remove the flag from a group of images, hold down Alt and
Shift and click any image in the selected group.

Customizing the flag color

1. On the lower bar, click the Tool Options button

.

2. Make sure that Flag Options is selected in the tool list.

3. Click the flag you wish to change.
The Flag Color dialog box appears.

4. Select the desired color and click OK.

Using the Image Info dialog box

View, edit, and update general information about the spotlight image in
the Image Info dialog box.

The Image Info dialog box shows EXIF information and the settings
used by the camera when the image was shot. The metadata shown in
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the Image Info dialog box was taken from the Info Settings dialog box
and attached to the image at the time that the shot was taken.

1. On the editing toolbar, click Image Info  .

2. Edit the image information as desired.

Note: For information regarding international metadata standards, go
to:The International Press Telecommunications Council at http://
www.iptc.org and The Dublin Core Metada Initiative at http://www.
dublincore.org.

See also:

The editing toolbar on page 12

Pixel information on page 20

Sorting and showing images
Sort your images, move images within a folder, or select images you
want to display.

Sorting your images

Sort your images by name, date, type, size, flag, Leaf back, or your own
order.

On the main toolbar from the Sort By list, select an option.

Moving images in your folder

Arrange the images in your folder in a particular order.

Do one of the following:

● In the thumbnails, click an image and drag it to the desired location.
● CTRL-click the image, and f rom the menu select Move To Top or

Move To Bottom.

Note: When you change the order of the images, you automatically
create a new Sort By order called My Order.

Selecting images to display

Select which images you want to be visible in the open folder.

On the main toolbar from the Show list, select an option.

Note: If you select an option where no images match the definition,
no images are shown in the display area.
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Managing your files

Moving an image to another location in the disk

 This task is performed on the Browse panel.

In the thumbnails click the image and drag it to the desired folder on
the Browse panel.

Moving an image to another disk

1. CTRL-click the image in the image area.

2. From the menu, select Move to Folder.

3. In the Move dialog box select the desired destination folder and
click Move.

Copying an image to another location in the disk

 This task is performed on the Browse panel.

In the thumbnails press Alt and click the image and drag it to the
desired folder on the Browse panel.

Copying an image to another disk

 This task is performed in the image area.

1. CTRL-click the image.

2. From the menu, select Copy to Folder.

3. In the Copy dialog box select the desired destination folder and click
Copy.
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Deleting an image

Moving an image to trash

Move an image to trash to delete the image without permanently
losing the file.

Select the image and then click Trash  on the editing toolbar.

Your image is moved to the Trash folder, but is not permanently deleted.

The Trash icon changes  to indicate that there are images in the
Trash.

See also:

The editing toolbar on page 12

Retrieving an image from Trash

 This task is performed on the Browse panel.

1. In the Favorites area, click Trash .
The Trash folder is selected in the directory area and its contents
appear in the image area.

2. From the image area, drag the thumbnail or the preview image that
you want to retrieve onto a folder in the Favorites area, or onto a
folder in the directory area.

Deleting an image permanently

1. Select the image you wish to delete.

2. Press Alt and then click Trash  on the editing toolbar.

The Trash icon changes as follows:

Hold down Alt and roll the mouse over the Trash icon. The trash icon

changes to the grim reaper  to indicate that you are about to
permanently delete the image.
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While still pressing Alt, click the grim reaper icon to permanently

delete the image. The icon changes to the skull and crossbones 
to indicate that the image is permanently deleted.

Renaming an image

1. Double-click the file name that appears under the thumbnail in the
image area.

2. Type a new file name.

Processing while editing
Process your image(s) at any time even while you are editing other
images.

Click Send to Process Queue  on the main toolbar.

Note: Your image is processed according to the parameters set on the
Process panel. If you know that the settings on the Process panel are
what you want, there is no need to set parameters on the Process
panel each time you process your image.

See also:

Monitoring the process on page 102
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6 Processing an image

Process your raw images to a standard file format with the desired size,
color, and image name. When you process your images, the mosaic file
is kept in its original form and any changes you make to an image affect
the processed image only. You can define a Processed folder where
your processed files will be placed.

When you process an image, your activities revolve around the Process
panel. If you do not want to make any changes to an image before
processing, you do not need to work on the Process panel.

You can prepare and process single or multiple images.

About the Process panel
When you process an image, your activities revolve around the Process
panel.

 

Processing an image
Prepare and process single or multiple raw images to a standard file
format with the desired size, color, and image name.

When you process your images, the mosaic file is kept in its original
form and any changes you make to an image affect the processed image
only. You can define a Processed folder where your processed files will
be placed.



When you process an image, your activities revolve around the Process
panel. If you do not want to make any changes to an image before
processing, you do not need to work on the Process panel.

To process the selected image click Send to Process Queue 
on the main toolbar.

See also:

Viewing the process log on page 103

Monitoring the process
Monitor the status of each image sent to process in the Process Queue
dialog box.

In the Process Queue area of the lower bar, you can find information on
the number of images sent for processing and the number of remaining
images to be processed.

The Process Queue dialog box contains a list of the images in progress
and their status. You can also view a thumbnail of the image when you
select it. When the running image is selected, a progress bar under the
thumbnail indicates the status of the processing.

See also:

Processing while editing on page 100
Opening processed images on page 112

Stopping processing
Stop an image being processed.

 This task is performed in the Process Queue dialog box,
accessed from the lower bar.

In the Process Queue dialog box select the image and click Cancel
File.
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Clearing the Process Queue
You can clear the Process queue by job status.

1. From the lower bar, click Process Queue to open the Process Queue
dialog box.

2. In the Process Queue dialog box, click Clear Done.
A dialog box appears.

3. Select all the job statuses you wish to clear from the Process Queue.

4. Click Clear
Jobs with the selected status are cleared from the Process queue.

Viewing the process log
View the log file for information about the images being processed and
the images deleted during the process.

 This task is performed in the Process Queue dialog box, opened
from the lower bar.  

Click Show Log.

A log file opens showing process information.

See also:

Processing an image on page 101

View the file path
View the location where you image is saved.

Place the pointer on an image.

The file path is shown.

Size overview
Use the Process panel Size tab together with the crop tool.

If you crop a certain area of the image using the crop tool, the values of
the cropped area after process are displayed on the Size tab.
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The default size of the output image is defined in the Image settings
that you selected for the shot.

Note: Changes that you make on this tab do not affect the size of the
original mosaic file.

To change the size of an individual image, do one of the following:

● Select a predefined output size
● Crop the image to create your composition, then specify the output

size
● Specify the required output size, then select the area of the image to

process to that size

See also:

Opening the Detail pane on page 8
Cropping an image on page 14

Predefined size settings

The Size tab's predefined setting list contains factory settings that are
suitable for different camera backs and standard output sizes. When
you select a predefined size setting, the Height, Width, and Scale
change accordingly.

 This task is performed on the Process panel Size tab.

In the predefined setting list, select the desired setting.

If you alter a predefined setting, for example by using the crop tool, the
setting is labelled custom and can be saved.

See also:

The predefined setting list on page 29

Cropping and specifying the output size

Crop the image to create your composition, and then specify the output
size.

 This task is performed on the Process panel Size tab.
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Note: You cannot crop a group of images taken with differing sensor sizes.

1. In the Res box, enter the desired resolution.

Note: The minimum resolution is 1 dpi; the maximum resolution is
800 dpi.

2. If you want an output size that is smaller than your image, use the
crop tool to select an area of the image.

The Height and Width boxes display the size of the selected area.

3. Use the Height and Width boxes to make fine adjustments to height
and width, if desired.

Tip: Select Constrain proportions to maintain the relationship
between height and width.

The image is cropped to the size set here. The crop is effective only
when the image is processed to a standard format. No crop is
implemented to MOS or HDR formats.

4. Click Save  to save the output size and crop location for future
use.

Specifying the output size and then cropping
Follow this method for specifying the output size when you have to
process your image to a specific size.

 This task is performed on the Process panel Size tab.

Note: You cannot crop a group of images taken with differing sensor sizes.

1. In the Width box, type the required width of the output image.

2. In the Height box, type the required height of the output image.

3. Select the Constrain Proportions check box.

4. Use the crop tool to select the desired area of the image.

5. In the Width or Height box, re-type the required width or height of
the output image.

If you type the width, the height is updated accordingly, and vice versa.

6. Click Save  to save the output size and crop location for future
use.
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Changing the size of multiple images
Change the size of a few images together.

 This task is performed on the Process panel Size tab.

1. Select the images. If the images were created with the same size
settings, the size values appear in the Width and Height boxes and
you should proceed to step 4. If the size settings used to create the
images vary, the words As Tagged in File appear in the Selected
Size Setting box.

2. In the Selected Size Setting box, view the available sizes. If the size
you want appears on the list, select a size and go straight to step 6.
If the size you want does not appear on the list, select any size from
the list.

3. Type a value in the Width or Height boxes, and press Enter.

Note: The minimum height and width is 1 pixel; the maximum height
and width is the full image size.

4. Type the resolution in the Res box.

Note: The minimum resolution is 1 dpi; the maximum resolution is
800 dpi.

5. If you want to save the values that you created, click Save.

See also:

The predefined setting list on page 29

Tips on setting image size
Set the resolution of your image in the Process panel Size tab.

About resolution

The resolution is the number of pixels per unit of printed length (inches
or millimeters) in an image. The higher the resolution value, the more
detail and subtler the color transitions are in the image. Different
output media support different output resolutions. The most popular
color output resolution is 300 dpi or 12 dpm.
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Color space overview
On the Process panel Color tab you can define whether the processed
image will be in color or grayscale, and choose the output profile or
working space that you want to use to convert the image.

Several output profiles and working spaces are available and which one
you choose depends on your output device.

Choosing a color space

 This task is performed on the Process panel Color tab.

The Color Space refers to an ICC output profile (RGB or CMYK) or RGB
working space. Every output device or location, such as a monitor,
printer or the Web, is characterized by a color space that contains the
colors that can be reproduced and determines how the colors are
reproduced. You should define a color space for your output image that
matches the color space used by the output device or location.

The color space of your output image is defined in the camera settings
that you selected for the shot. On the Color tab, you can view and
change the color space of the output image and set a uniform output
color space for a group of output images.

The RGB produced by each Leaf camera back is referred to as Camera
RGB. The gamut of any Leaf Camera RGB is larger than any RGB
working space. The closest published RGB working space is Kodak®

ProPhoto RGB.

The following procedure can be performed on one or more images.

1. From the Color list select Color to create a color image, or
Grayscale to create a black and white image.

2. From the Color Space list, select an ICC output profile.

Note: Changes that you make here affect only the color of the
processed image and do not affect the original mosaic file.

 If you selected more than one image, and the color space settings are
the same for each image, the color space values appear. If the output
color space for the images vary, the words As Tagged in File appear in
the Color Space box.

See also:

Customizing camera configuration on page 36
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Editing a color profile
Edit an existing color profile using one image or a number of images in
the ProfileEditor software.

Note: Custom color profiling is currently only supported on Macintosh.

 This task can be performed on the Adjust panel or Process
panel Color tabs.

1. Select an image with the color profile that you want to edit.

Note: You can work on only one image at a time in the ProfileEditor.
If you select more than one image, it is the spotlight image that
opens in the ProfileEditor software.

2. In the Color Look / Color Space list, select a color profile.

3. Click Edit Profile.
ProfileEditor opens with the image that you selected.

4. Use ProfileEditor to edit the color profile. Ensure that P (Perceptual)
intent is selected before you edit your profile. For assistance, refer to
the ProfileEditor help files.

If you do not want to use more images to edit the profile, go to step
13.

5. In Leaf Capture, select all further images you wish to use.

6. On the Process tab > Format box, ensure that either a TIFF (8bit) or
JPEG file format is selected.

7. In the Color Space list select Camera RGB.

8. Click Send to Process queue .

9. In the ProfileEditor software, close the image that is currently open.

10. Click Open Image, navigate to the Leaf Capture Processed folder,
and select the next image you wish to use.

11. Use ProfileEditor to continue editing the color profile.

12. Repeat steps 9-11 for every additional image that you want to use.

13. If you create a new profile, the profile must be saved in one of the
Macintosh ColorSync Utility profile folders before you can work with
it in Leaf Capture. We recommend that you save it in the Library /
Colorsync / Profiles folder in your own user folder.
The new or edited profile appears in the Color Look list.

Note: It may take a few moments to appear in the list.

14. In the Color Space list, select the edited color profile.
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Tips on color for processing
Set the color profile of your processed images in the Process panel
Color tab.

Leaf digital camera backs have large color gamuts which means that
most colors can be accurately reproduced when an image is transferred
from one device to another. Therefore, it is advisable to work with a
large gamut, or wide RGB working space, when transferring the image
to other software. Examples of wide color spaces are ProPhoto RGB
and Adobe® RGB. An example of a narrow color space is sRGB.

Use the Output Values option to check the neutrality of grays, as well
as the level of detail and color in highlight or shadow areas. In general,
it is recommended that you use this option when you need to know,
check, or adjust the numerical values of colors in your image. For
example, in RGB, the highlight detail values should be below 248 sv and
the shadow detail values above 10 sv.

Note: Changes that you make on the Process panel Color tab only
affect the color of the processed image and do not affect the original
mosaic file.

When processing an image to JPEG (Fast Preview) format, the sRGB
working space will automatically be embedded, regardless of the
profile you have selected in the Color Space list.

About Destination
The Process panel Destination tab enables you to manage your
processed files.

You can choose a processed folder, give your final image a name and
open it in third-party software, such as Adobe Photoshop®.

Selecting a format
Select an output file format for your processed images.

 This task is performed on the Process panel.

1. To select a file format, from the Format list select the desired format.
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If you selected JPEG, JPEG (Fast Preview), TIFF (16 bit) + Preview,
TIFF (8 bit) + Preview, JPEG + Preview, Leaf HDR + Preview, or
Leaf Mos, the Settings button becomes available.

2. Click Settings and modify the relevant format settings:

Optimization Select from Progressive Baseline Optimized and
Baseline (Standard)

Quality Choose the quality of the image from the list. The lower
the quality, the smaller the file size.

Max Height Enter the maximum height in pixels of your preview
image. (File formats with preview only)

Max Width Enter the maximum width in pixels of your preview
image. (File formats with preview only)

Note: If you selected Leaf Mos, specify the format settings.

See also:

Applying lens calibration to an image on page 113

File formats
Select the file format for your processed images in the Process panel.

The following formats are available:

● TIFF 16 bit:This is a standard 16-bit format. The color is managed by
ICC profiles so that the file can be opened in Adobe Photoshop or
other ICC-compliant software. The appearance of the image is the
same when opened in other software as it is in the Leaf Capture
software.

● TIFF 8 bit: This is a standard file format that you can open with
imaging software such as Adobe Photoshop software. Use this
format when interfacing with other graphic arts software.

● JPEG: Choose this format when you are creating images for Web
sites. It stores images in a compressed form; therefore, when you
use this format there may be quality loss. JPEG format is recognized
by all graphic arts and Internet software.

● Leaf HDR: The Leaf HDR (high dynamic range) file format contains
16 bits of information per channel. The Leaf Volare digital camera
back produces HDR image files. A Mosaic 1-shot file can be
processed into an HDR file. Select this format if you want to save
your image after color interpolation.

● TIFF (16 bit) + Preview: A TIFF 16 bit image is produced and a JPEG
(Fast Preview) image for you to preview.
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● TIFF (8 bit) + Preview: A TIFF 8 bit image is produced and a JPEG
(Fast Preview) image for you to preview. 

● JPEG + Preview: Select to produce both a JPEG and a JPEG (Fast
Preview) image.

● Leaf HDR + Preview: Select to produce both a Leaf HDR file and a
JPEG (Fast Preview) image.

● Leaf Mos: Select to perform custom gain adjustment on your raw files.

Managing processed images
Define the destination settings for your processed images on the
Process panel Destination tab.

Naming processed images

 This task is performed on the Process panel Destination tab, in

advanced mode .

Tip: For additional options work in advanced mode, which enables you
to work with a prefix or suffix, and to append the name if working with
multiple images.

1. In the File box, type a name for your processed image.

2. If you wish to use a prefix or suffix:

a. Click  and select Advanced Mode.
b. In the Prefix and Suffix boxes, type the prefix, suffix, or both, in

the relevant box.

3. If you do not want the file name extension to appear:

a. Click  and select Advanced Mode
b. Clear the Append Extension check box.

Note: If you are working with multiple images, they are named
according to the following convention:<prefix if selected><original
filename><suffix if selected>.<extension if selected>

Designating a folder for processed images

When you process your images, by default they are sent to the
processed folder in the <user>/pictures/leaf images folder. You can
change the destination folder for processed images.
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 This task is performed on the Process panel Destination tab.

1. In the Folder area, click .

2. In the Choose Processed Folder window select a new folder for
processed shots and click Choose.

The Process shortcut on the Browse panel Favorites area is now the
folder you selected.

Note: Until you designate a different destination folder, all your
future shots are saved to the last designated folder.

Note: You can also designate the processed folder while working in
the Browse panel. Right-click the desired folder in the directory area,
and select Set As Processed Folder.

Opening processed images
You can open your processed images in one of the following ways:

● by opening them from the Process folder  in the Favorites
area

● by opening them from the processed folder in the Browse panel
directory area

● by opening them from the processed folder in your computer's
Finder or Explorer

● by setting your images to automatically open in other software once
processed

See also:

Monitoring the process on page 102

Opening processed images in other applications
Before processing, set you images to be automatically opened in
designated software once processed.

 This task is performed on the Process panel Destination tab.

1. Select Open with.

2. In the Specify path window, select the software with which you wish
to open the processed shots.
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3. Click Open.

Once processed, your images are automatically opened in the
designated software.

Applying lens calibration to an image
Shooting images with wide angle lenses and exploiting large format
camera movements often results in lens fall-off and color distortion.

For more information on cast effects in wide angle photography and the
suggested workflow for taking wide angle shots, refer to the Custom
Gain Adjuster documentation on the web: https://www.leaf-
photography.com/ShowFaqs.asp?MenuID=373&ParentMenuID=355

For Leaf AFi-II 10 and Aptus-II 10 users, Leaf Capture is released with a
Lens Calibration Data CD. This CD contains lens calibration files, which
are unique to your imaging module, for most commonly-used lenses.
For more information on using lens calibration files, refer to the Lens
Calibration Guide for Leaf AFi-II 10 and Aptus-II 10 Camera Backs (p/n
731-01750A-EN).

The way to correct cast effects is to take a diffused lens calibration shot
prior to, or immediately following, the actual scene capture of every
camera and lens setup used. After the shoot, you correct the cast effect
using the diffused lens calibration shot.

Apply the custom lens calibration to your images by processing to
create new raw files. First, set the processing workflow, and thereafter
process two or more images together, setting one file as the lens
calibration file.

To match your workflow on the shoot, you can set either the first or last
image in the selected group to be used as the lens calibration file.
Alternatively, you can select a particular file.

 This task is performed on the Process panel.

1. In the Format list, select Leaf Mos.

2. Click Settings.
The Leaf Mos Settings dialog box opens.

3. To save the mos file with lossless compression, select Save
Compressed.

4. Select Lens Calibration Adjustment.

Applying lens calibration to an image 113

https://www.leaf-photography.com/ShowFaqs.asp?MenuID=373&ParentMenuID=355
https://www.leaf-photography.com/ShowFaqs.asp?MenuID=373&ParentMenuID=355


5. Select which image should be used as the lens calibration file:

● Click Use First Calibration File to select the first file selected in
the group

● Click Use Last Calibration File to select the last file selected in
the group

● Click Select Calibration File and choose an independent file

Note: For the source lens calibration file, you must use an image
with sensor size at least as large as the target files.

6. In the % Falloff Correction box, adjust the fall off by typing the
desired correction percentage.

7. Click OK.
Your lens calibration settings are saved.

8. Select and process your images by groups.

See also:

Selecting a format on page 109
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7 Keyboard shortcuts

General

Commands Shortcut for Mac OSX Shortcut for Windows®

Open file Command  O Ctrl O

New folder Command N Ctrl N

Save As Shift Command  S Ctrl Alt S

Save Selected Command  S Ctrl S

Rename Selected Command  R Ctrl R

Process Selected Command  E Ctrl E

Save Selected Previews Shift Command  P Ctrl Shift P

Print Command  P Ctrl P

Move to Trash Command Backspace Ctrl Backspace

Editing

Commands Shortcut for Mac OSX Shortcut for Windows

Undo Command  Z  Ctrl Z

Redo Command  Y Ctrl Y

Cut text Command  X Ctrl X

Copy text Command  C Ctrl C

Paste text Command  V Ctrl V



Commands Shortcut for Mac OSX Shortcut for Windows

Select all images Command  A Ctrl A

Clear selection of all
images

Option Command  A Ctrl Alt A

Editing Tools

When working on an image, use these shortcuts to switch between tools.

Commands Shortcut for Mac OSX Shortcut for Windows

Zoom tool Z Z

Hand tool (pan) H H

Tip: When the image is zoomed and another tool is active, hold down the space
bar to temporarily activate the Pan tool.

Picker (info) tool I I

Flag 1 tool 1 1

Flag 2 tool 2 2

Flag 3 tool 3 3

Flagging a selected group
of images

Alt Shift click any image
in the selected group

Alt Shift click any image
in the selected group

Crop tool C C

Detail window tool D D

Loupe tool O O

Editing Tools
Available when Moire Reduction is set to Selective.

Commands Shortcut for Mac OSX Shortcut for Windows

Lasso L L

Polygonal Lasso P P
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Commands Shortcut for Mac OSX Shortcut for Windows

Rectangle Marquee M M

Ellipse Marquee E E

Camera

Commands Shortcut for Mac OSX Shortcut for Windows

Connect to camera Command  K Ctrl K

Take picture Command  T Ctrl T

Camera Configuration Control Command  C Ctrl Alt C

Image Settings Control Command I Ctrl Alt I

Live View

Commands Shortcut for Mac OSX Shortcut for Windows

Make fine adjustments to
the live exposure time

Alt + Increase or
Decrease Live Exposure
Time

Alt + Increase or
Decrease Live Exposure
Time

Play live view Ctrl  L Ctrl Alt L

Stop live view Ctrl  . (period) Ctrl Alt  . (period)

Image

Commands Shortcut for Mac OSX Shortcut for Windows

Adjust Gray Balance Command  B Ctrl B

Adjust Develop Curve Command  D Ctrl D

Adjust Color Command  U Ctrl U

Adjust Process Filter Command  F Ctrl F

Adjust Sharp Command  G Ctrl G
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Commands Shortcut for Mac OSX Shortcut for Windows

Apply Flag 1 to image Ctrl  1 Ctrl Alt 1

Apply Flag 2 to image Ctrl  2 Ctrl Alt 2

Apply Flag 3 to image Ctrl  3 Ctrl Alt 3

Show Over Option Command  O Ctrl Alt O

Show Under Option Command  U Ctrl Alt U

Invert Mask Selection Shift Command  I Ctrl Shift I

View

Commands Shortcut for Mac OSX Shortcut for Windows

Thumbnails Vertical Shift Command  V Ctrl Shift V

Thumbnails Horizontal Shift Command  H Ctrl Shift H

No Thumbnails Shift Command  P Ctrl Shift P

Thumbnails Shift Command  T Ctrl Shift T

List Shift Command  L Ctrl Shift L

Slides F5 F5

Set candidate as master
in compare view

Alt Enter Alt Enter

Flip through candidate
images

Alt Arrow keys Alt Arrow keys

Choose a candidate image Alt click image Alt click image

Refresh compare pane
layout

Shift Command  R Ctrl Shift R

Toggle compare view size tab tab

Show actual pixels Option Command 0 Ctrl Alt 0
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Commands Shortcut for Mac OSX Shortcut for Windows

Hide/show grid Command ' Ctrl '

Hide/show layout overlay Option Command ' Ctrl Shift '

Fit to preview size Command 0 Ctrl 0

Zoom in on current
location

Command - Ctrl -

Zoom out of current
location

Command + Ctrl +

Enlarge scale of overlay Command Alt -  

Reduce scale of overlay Command Alt +  

Adjust location of overlay Arrow keys Arrow keys

Hide/show functions area tab tab

Hide/show crop mask Command M Ctrl M

Display all channels Command F1 Ctrl F1

Display R / Cyan Command 1 Ctrl 1

Display G / Magenta Command 2 Ctrl 2

Display B / Yellow Command 3 Ctrl 3

Display Black Command 4 Ctrl 4

Preview Monitor

Commands Shortcut for Mac OSX Shortcut for Windows

Display new shots in the
image area

Command N Ctrl N

Do not display new shots
in the image area

Shift Command A Ctrl Shift A

Open Preview Monitor Command M Ctrl M
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Commands Shortcut for Mac OSX Shortcut for Windows

Show Image Info Command I Ctrl  I

Detach and Dock
Histogram

Control Command H Ctrl Alt H
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8 Reference

Leaf Capture menu
About Leaf Capture Display the Leaf Capture software

version and legal information

Preferences Open the Preferences window

Services > Open a submenu giving access to other
Mac software

Hide Leaf Capture Hide Leaf Capture software

Hide Others Hide other software

Show All Show all open software

Quit Leaf Capture Quit the Leaf Capture application

File menu
Open File Open a file or folder

New Folder Create a new folder

Save Save the image

Save As Open the Save dialog box where you can give
the image a name and select where to save it

Open Overlay Open a layout overlay

Process Process the selected file(s)

Pause Processing Pause the processing of your images

Set As Shots folder Set selected folder as the Shots folder



Add to Favorites Add a shortcut to the selected folder to the
Favorites area

Set As Processed Folder Set selected folder as the processed folder

Move To Trash Move selected item to trash

Empty Trash Empty the trash folder

Edit menu
Undo not available in this version

Redo not available in this version

Cut Text Cut selected text

Copy Text Copy selected text

Paste Paste selection

Select All Select all images in the current folder

Deselect All Deselect all images in the current selection

Copy to Folder Copy selected images and save in another folder

Move to Folder Move selected images to another folder

 

Camera menu
Camera Configuration Open the Camera Configuration dialog box

Info Settings Open the Info Settings dialog box

Lens Calibration File > Click to access the Create Lens Calibration Wizard
and to load a lens calibration file
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Connect Connect to the Leaf digital camera back

Take Shot Take a shot

 

Image menu
Adjust > Switch to the Adjust panel tabs

Rotate > Rotate the image

Flag > Flag the image

Show Over Show over exposure in the selected image

Show Under Show under exposure in the selected image

Invert Mask Selection Invert the selected area of the moire reduction
selection tool

 

View menu
Preview > Select the view mode

Thumbnails Select thumbnail view

Compare Open compare view

Compare Actions > Switch the candidate and master images and
refresh the layout when you are comparing
multiple images

Slides Start a slide show of the shots in the folder

Do Not Select New Shots Do not automatically show each new shot in
the image area during a shoot session

Preview Monitor > Define what is shown in the Preview Monitor
window
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Show/Hide Functions Area Show or hide the panels area

Channels > Show color channels together or separately

Actual Pixels Show spotlight image at actual pixels size

Fit To Preview Resize the spotlight image to fit into the
preview area

Zoom In Zoom into the image

Zoom Out Zoom out of the image

Sort By > Sort images in the folder

Show/Hide Overlay Show or hide the layout overlay

Layout Overlay > Move or rescale the layout overlay

Show grid Show a grid over the image

Show > Show selected images

Windows menu
Shoot Access the Shoot panel

Adjust Access the Adjust panel

Process Access the Process panel

Browse Access the Browse panel

Navigation Open the Navigation pane

Detail Open the Detail pane

Process Queue Open the Process Queue dialog box

Pixel Info Open the Pixel Info box

Tool Options Open the Tool Options box

Image Info Open image info dialog box
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Detach Histogram Panel Detach the histogram

Preview Monitor Open the Preview Monitor window

Help menu
Leaf Capture Help Display the Leaf Capture help system
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Index
A
Adjust panel 57
adjusting 57, 59, 76, 77
alarms 47, 63
aperture 43

B
batch processing 101, 103
Browse panel 23
browsing 23

C
camera configuration 36
camera control 41
color management 76
color profile 73, 74, 76, 108

adjusting color saturation 76
using 76

color saturation 76
color sliders 59
Color Space setting 74, 108
Color tab

about 76
color profile 73
creating a color profile 73

color values 20
compare view 91
connection to the camera 35, 36

connecting 35
copying images 89, 98
creating 25, 63, 73

develop curve automatically 63
ICC profiles 73

crop
sensor 42

curve 61
customizing 13, 37

D
deleting images 99
Detail pane

about 8
Develop curve 47, 61–63, 66, 68, 70, 71

about 61
creating automatically 63
exposure alarms 47, 63

disconnecting 36

E
editing an image 89

editing images 8, 12, 13, 17, 89, 95–97
customizing 13
Detail 8

EV compensation 44
evaluating 46, 61, 71

tone 71
exposure 41, 44, 47, 52, 63

compensation 44
exposure alarms 47, 63
meter 41

F

file format 109
Filter tab 77, 79, 85

grain, adjusting 77
flag 95, 96
flash sync 45
focus 17, 53

Loupe tool 17
folder 25

creating 25
Format box 74, 108
format, file

selecting 109

G

grain, adjusting 77
gray balance 55, 58, 60, 61

evaluating 61
Gray Balance Highlight Gray Picker tool 60
Gray Balance Shadow Gray Picker tool 60

gray balance picker 55
GretagMacbeth 73
grid tool 15

H

highlight, controlling 85

I

ICC profile 76
image 10, 25, 33, 46, 57, 89, 95–98

adjust 57
editing 89
evaluate a shot 46
flag 96
open 25
rotate 95
sort 97

image gray balance picker 58



image settings 36, 37
customizing 37

image tab 37
info settings

customize 37
open 12

intensity 83
ISO 42

K

keyboard shortcuts 115

L

layout overlay
layout overlay tool 16

level curve 61
live view 49–53, 56

color 52
exposure time 52
focusing with 53
functions 49
playing 51

loupe tool 17
lower bar 19

M

main menu 4
metering mode 44
mirror control 45
moire, reduction 79–81

reducing moire 79
monitor 90

N

Navigation pane 9, 12
zoom tool 12

neutralize 61
noise reduction 77

O

output profile 74, 108

P

panel buttons 7
Picker tool 18, 55, 58

Image Gray Balance 58
pixel information 20
predefined setting 29–31

factory 29

in file 29
saved 29

Process panel 101
Process Queue 102
processing an image 101, 103

R

radius 83
rename images 100
retrieve from trash 99
RGB

measuring 18

S

save 39
screen 101
select 26, 36, 104, 109

camera setting 36
file format 109

SensorFlex 42
shadow, controlling 85
sharpness 82–86

about 82
filtering the image 85
selecting a color chanel 85
setting the intensity 83
setting the radius 83

Shoot panel 33, 47, 63
histogram 47, 63

shoot, preparing for 35
shortcuts 115
shot 35, 36, 39, 45

camera configuration 36
preparing for 35
saving 39

shutter speed 44
size 103, 104, 106

changing 103
Smooth slider 84
Strength command 86

T

temperature 59
tethered mode, taking a shot in 45
Threshold command 86
tint 59
Tone curve 61
Tone Reproduction curve 61
tools 12
trash

retrieving images from 99
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U

unsharp mask 82

V

viewing 6

W

welcome 1
white balance 61
workspace 3, 4, 7, 10, 19, 21, 23, 101

arranging. for processing 101
Browse panel 23
image area 10
lower bar 19
main menu 4
main toolbar 4
panel buttons 7

Z

zoom tool 14
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